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2.2. Boş Belge Açmak 
 

Flash yazılımını çalıştırdıktan sonra ekrana 550 px (piksel) genişliğinde 400 px 

yüksekliğinde boş bir çalışma ortamı gelir. Çalışma ortamı içinde Tools, Timeline, Color 
Mixer, Color Swatches, Components ve Properties panelleri bulunmaktadır. 

 

 
 

Şekil 2.3: Boş çalışma sayfasıyla ekrana gelen Flash editörünün görüntüsü 
 

Editör öğelerini; şekil 2.3’te yapılmış olan numaralandırmaya göre açıklayabiliriz. 
 

1: Zaman doğrusu (timeline). Kare kare canlandırma hazırlanırken zaman doğrusu 

üzerindeki çerçeveler (frame) kullanılır. 
 

2: Flash film dosyalarında kullanılan katmanlar (layer) gösterilir. Katmanlarla ilgili 

işlemler buradan yapılır.  
 

3: Flash’ta grafik çizimleri için gerekli olan araçların bulunduğu araç kutusudur. 
 

4: Flash çalışma alanında ve panellerinde yer alan tüm nesne ve araçların sahip 

oldukları özelliklerin gösterildiği Property Inspector (Özellik Sorgulayıcısı) panelidir. 
 

5: Grafikler üzerinde çeşitli renk işlemlerinin yapıldığı Color Mixer (Renk 

Karıştırıcısı) ve Color Swatches (Renk Pastelleri) panelleridir. 
 

6: Radyo düğmesi, kaydırma çubuğu (scroll bar), kontrol kutusu (check box), buton 

gibi kullanıcı hareketine duyarlı bileşenlerin çalışma sayfasına eklenmesini sağlayan 

Components (Bileşenler) panelidir. 
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Uygulama-2.3: Panellerin üzerinde hareket işlemlerinin yapılması ve bazı 

özelliklerinin değiştirilmes; 

1- Şekil 2.4’te gösterilen Tools panelini bulunuz ve farenin sol tuşuyla sürükleme 

yapılacak alana (kırmızı daire içinde gösterilen alan) tıklayınız. 

2- Tuşu basılı tutarak fareyi çalışma alanına doğru sürükleyiniz. 

3-  Araç kutusunun üstünde gözüken yandaki alanda çarpı işaretine 

tıklayarak araç kutusunu kapatınız. 

4- Windows → Toolbars komutuyla araç kutusunu yeniden görünür hale getiriniz. 

5- Araç kutusunu ilk konumuna taşımak için araç kutusu üstündeki alana sol tuşla 

tıklayın. Tuşu bırakmadan araç kutusunu ekranın sol tarafına doğru sürükleyiniz 

ve bırakınız. Araç kutusunun yerleşiminde bir değişim görülecektir. 

 

Şekil 2.4: Grafik çizimleri için 

araç kutusu paneli 

 

Şekil 2.5: Bileşenler paneli 
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Şekil 2.6: Boş film karesinin eklenmesi 

5- Edit → Paste in Place (Aynı yere yapıştırın) komutunu veriniz. Araç kutusundan 

metin yazma aracını seçiniz ve Çalışma Alanı-1 yazısının içine girerek 1 

rakamının yerine 2 yazınız. 

6- 4. ve 5. adımları zaman doğrusunda 5. kareye kadar tekrarlayınız. 

7- Çalışma dosyanızı ilk animasyonum adıyla kaydediniz ve Control → Test Movie 

komutunu veriniz. 

8- Hazırladığınız canlandırma Çalışma Alanı-1’den Çalışma Alanı-5’e kadar 

sayıyorsa şekil 2.7’de gösterilen bölgeye çift tıklayarak daha önceden Modify → 

Document… komutunu kullanarak açtığınız Document Properties penceresini 

açınız. 

 

Şekil 2.7: Sayfa özelliklerine zaman doğrusundan ulaşılması 

9- Kare hızını 20’den 5’e ayarlayınız. Filminizi Control → Test Movie komutuyla 

yeniden çalıştırınız. Filmin önceki çalışmasıyla şimdiki çalışması arasında bir fark 

var mı? 

Fps Hakkında: Kare hızı (Frame Rate) ayarlanırken fps (Frame Per Second) 

seçeneği  vardır.. Bu  1 saniye içinde gösterilecek kare sayısını belirtir. 
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Uygulama-2.6: Flash filmine birden fazla sahne eklemek. 

1- Boş çalışma sayfası açınız. Şekil 2.15’in 1. karesinde görüldüğü gibi çalışma 

sayfanız Scene 1 isimli sahneyle ekrana gelir. 

 

Şekil 2.15: Flash’ta sahneler 

2- Yeni bir sahne eklemek için menü çubuğunda Insert → Scene komutunu veriniz. 

3- Sahneler arası geçiş yapmak için şekil 2.15’in 4. karesinde gösterildiği gibi Edit 

Scene ( ) butonuna tıklayınız. Çıkan listeden, üzerinde çalışmak istediğiniz 

sahneyi seçiniz. 

Çalışma sayfası üzerinde yapılan her türlü grafik işlemi, açık olan sahne üzerinde 

yapılır. Filminizi Ctrl+Enter tuş ikilisiyle ya da Control → Test Movie komutuyla 

başlattığınızda, eğer özel bir müdahale yapmamışsanız sahnelerde yaptığınız çalışmalar 

sırayla oynatılır. 
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ÖĞRENME FAALİYETİ–3 
  

  

Bu öğrenme faaliyetinde çeşitli canlandırmalar ve uygulamalar hazırlarken çok sık 

olarak faydalanılan grafik araçlarının kullanımını öğreneceksiniz. 

  

 

Farklı grafik düzenleme yazılımlarının grafik araçlarını inceleyerek Flash yazılımıyla 

olan benzerlik ve ayrılıklarını anlamaya çalışınız. 

 

3. GRAFİK ARAÇLARINI KULLANMAK 
 

Uygulamalara geçmeden önce araç kutusunda yer alan Options seçeneğini kısaca 

açıklamak yerinde olacaktır. 

 

Şekil 3.1: Araç kutusunda yer alan Options bölümündeki ek özelliklerin seçilen araca göre 
değişmesi 

ÖĞRENME FAALİYETİ–3 

 AMAÇ 

 ARAŞTIRMA 
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İpucu : Eğer dörtgenin yalnızca bir kenarını seçmek istiyorsanız seçmek 

istediğiniz kenar çizgisine bir kez tıklayınız. 

 

10- Edit menüsünden Undo komutuyla ya da Ctrl+Z tuşlarıyla silme işlemini geri 

alınız. Çalışma alanında boş bir yere tıklayarak çerçeveyi seçili durumdan 

kurtarınız. 

 

 İpucu : Ctrl+Z tuşlarını kullanarak bilgisayarınızın sistem hafızası 

kapasitesine göre geçmiş eylemlere dönebilirsiniz. 

11-  Subselection Tool aracıyla dörtgenin çerçevesine farenin sol tuşuyla bir kez 

tıklayınız. Dörtgenin çerçevesi şekil 3.22’deki durumu alır. 

 

 
Şekil 3.22: Subselection aracıyla 

dörtgenin seçilmesi 

Şekil 3.23: Dörtgenin başka bir noktaya taşınması 

Subselection Tool – Altseçim Aracı: Subselection aracıyla seçilen bir 

çerçevenin içinde kalan alan da seçilir. Ayrıca seçilen çerçeve üzerinde çeşitli tutma 

noktaları oluşturularak şeklin bu noktalardan değiştirilmesi sağlanır.  

12- Subselection aracıyla dörtgenin etrafını kaplayan çerçeveyi seçtikten sonra 

farenin tuşunu bırakmadan dörtgeni farklı bir bölgeye taşıyınız. Dörtgenin iç 

dolgusuyla birlikte taşındığını göreceksiniz (Şekil 3.23). 

13- Dörtgenin etrafında içi boş küçük kareler şeklinde oluşan noktalara Subselection 

aracıyla tıklayarak tuşu bırakmadan fareyi sürükleyiniz ve bırakınız. Bu işlemi 

farklı noktalar için tekrarlayarak dörtgenin şeklini değiştiriniz (Şekil 3.24). 
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(A) (B) (C) 

Şekil 3.24: (A) Subselection aracıyla bir grafik öğesi seçiliyor. (B) Farenin sol 

tuşuna basarak tutamaçlardan biri tutuluyor. (C) İmleç grafiğin dışına 

sürükleniyor 

14- Çalışma sayfanıza yaklaşık 200 px genişliğinde bir oval çiziniz. 

15- Araç kutusundan Arrow Tool aracını seçiniz ve çizdiğiniz çemberi çevreleyen 

çizgiye tıklayarak seçili duruma getiriniz. 

16- Çevre çizgisini siliniz. Araç kutusundan Lasso Tool aracını seçiniz ve 

dairenin bir bölümünü içine alacak şekilde seçili duruma getiriniz. 

 
(A) (B) 

Şekil 3.25: (A) Lasso Tool aracıyla nesnenin istenen parçası seçiliyor. (B) Seçilen alan 

Lasso Tool – Kement Aracı: Serbest seçim yapmak için kullanılır. Fare 

imlecini seçime başladığınız noktaya kadar sürüklemenize gerek yoktur. Başladığınız 

noktayla sürüklemeyi bitirdiğiniz nokta arasını seçili duruma getirir. 

17- Araç kutusundan Arrow Tool aracını seçiniz ve az önce seçmiş olduğunuz 

parçanın üzerine tıklayarak tuşu bırakmadan farklı bir konuma sürükleyiniz. 

18- Yine ok aracıyla bu sefer oval şeklin dışına tıklayarak belli bir bölgesinde düz 

seçim alanı oluşturacak şekilde fareyi şekle doğru sürükleyiniz. 
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(A) (B) 

Şekil 3.26: Ok aracıyla bir grafikte düz seçim bölgesinin oluşturulması 

19- İstediğiniz bölgeyi seçtikten sonra siliniz. 

20- Ok aracı seçiliyken fare imlecini şeklin istediğiniz bir kenarına yaklaştırınız. 

Arrow Tool – Ok Aracı: Flash yazılımında en sık kullanılan araçtır. Pek çok 
işlem yapabilme özelliğine sahiptir. Bu araç seçiliyken imleci bir nesnenin kenarına 
getirdiğinizde imleç iki şekilden birini alır: 

 Eğer yaklaşılan kenar yumuşak kıvrımlardan oluşuyor ya da tamamen düzse 

 şeklini alır. 

 Yaklaşılan kenar keskin köşeliyse  şeklini alır. 

21- Fareyi sol tuşa basılıyken istediğiniz bir noktaya sürükleyiniz. Örnekte şeklimiz 
şekil 3.27’deki görüntüyü almıştır. Seçme araçlarıyla farklı uygulamalar yaparak 
elinizi bu tür uygulamalara alıştırmaya çalışınız. 

 
(A) (B) (C) 

Şekil 3.27: (A) Fare imleci şeklin düz kenarına yaklaştırılıyor. (B) Fare imleci sol tuşa basılarak 

şeklin dışına doğru sürükleniyor. (C) Fare tuşu bırakılıyor 

Uygulama-3.8:Free Transform Tool aracıyla grafik öğeleri üzerinde değişikliklerin 

yapılması 
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Free Transform Tool – Serbest Dönüşüm Aracı: Bu aracı nesneleri, 

metinleri, grup altına alınmış öğeleri ve flashın örnek öğelerini (instances) istenildiği gibi 

döndürmek ve boyutlandırmak amacıyla kullanabilirsiniz. 

1- Çalışma sayfasına üzerine, Free Transform Tool aracını uygulayacağınız bir 

dikdörtgen çiziniz. 

2- Araç kutusundan  Free Transform Tool aracını seçiniz. 

3- Eğer çizdiğiniz dörtgenin çerçevesi varsa ve bunu da seçime dâhil etmek 

istiyorsanız farenin sol tuşuyla dörtgene iki kere tıklayınız (Bir kez tıklayacak 

olursanız yalnızca dolgu kısmı seçilir, çerçeve seçimin dışında kalır). 

4- İmleç  şeklini alır. Şekil 3.28’de seçili dörtgenin farklı noktalarına 

yaklaştırılan fare ikonunun değişimi gösterilmiştir. 

 
(A) (B) (C) 

Şekil 3.28: (A) Dörtgenin çerçevesiyle birlikte seçilmesi. (B) Fare imlecinin yan, üst ve köşe 

noktalarına yaklaştırılması sonucu aldığı şekil. (C) Fare imlecinin dörtgenin dönme merkezine 

yaklaştırılması sonucu aldığı şekil 

5- İmleç şekil 3.28 (A)’daki görünümü aldığında dörtgeni farenin sol tuşuna 

basılıyken farklı bir noktaya sürükleyiniz. 

6- İmleç şekil 3.28 (B)’deki görünümlerden birini aldığında seçili dörtgeni ok yönleri 

doğrultusunda uzatıp daraltabilirsiniz. 

7- Fare imlecini dörtgenin sağ alt köşesine yaklaştırınız ve sol tuşa basılıyken yukarı 

doğru döndürünüz. Tuşu bıraktığınızda şekil 3.29’dakine benzer bir konum 

alacaktır. 

 
(A) (B) (C) 

Şekil 3.29: Dörtgenin merkez dönme noktasına göre döndürülmesi 
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8- Her nesnenin bir dönme referans noktası vardır. Bu nokta varsayılan olarak 

merkezdedir. İmleç şekil 3.28 (C)’deki görünümü aldığında dörtgenin dönme 

noktasını değiştirebilirsiniz. Dönme noktasını dörtgenin sağ üst köşesine 

yaklaştırınız. 

9- Fare imlecini dörtgenin istediğiniz bir noktasına yaklaştırınız. Fare imleci dönen 

ok şeklini aldığında sol tuş basılıyken şekli istediğiniz yönde hareket ettiriniz. 

 
(A) (B) (C) 

Şekil 3.30: Dörtgenin dönme noktasının değiştirilmesi 

10- Fare imlecini sağ ve üst orta noktadaki tutamaçlara imleç (  ya da ) şeklini 

alacak şekilde yaklaştırınız. Bu durumda şekil iki yöne doğru eğilerek 

değiştirilebilir. 

İpucu : Serbest dönüşüm işlemi için, Modify menüsünden de yapılabilir. 

Dönüşüm işlemi yapmak istediğiniz nesneyi seçili duruma getirip Modify 

menüsünden Transform komutunu veriniz. Şekil 3.31’deki menü karşınıza 

gelir.  

 
Şekil 3.31: Modify → Transform menüsünün alt seçenekleri 
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Şekil 3.34: Gradyent aracı olarak Linear modunun seçilmesi 

6- Menünün yanında yer alan  simgesine tıklayınız ve bir dolgu rengi 

belirleyiniz. 

 
(A) (B) (C) (D) 

Şekil 3.35: (A) Solid dolgulu grafik nesnesi (B) Linear gradyent etkisinin uygulanması (C) 

Linear gradyent etkisinin ters çevrilmesi (D) Ara gradyentin eklenmesi 

7- Şeklinizin dolgu renginin yoğundan aza doğru değiştiğini görmeniz gerekir. 

8- Ton değişimini renk değiştirme tutamaçları yardımıyla farklılaştırabilirsiniz. 

Şekil 3.36’da görüldüğü gibi fare imlecini soldaki tutamacın üzerine tıklayınız ve 

sağ tarafa sürükleyiniz. Benzer şekilde sağdaki tutamacı da sola sürükleyiniz. 

Aynı etkiyi tutamaçların renklerini değiştirerek de yapabilirsiniz. 

 

 
Şekil 3.36: Tutamaçların yerleri 

değiştiriliyor. 

Şekil 3.37: Yeni bir tutamaç eklenerek 

gradyent etkisi değiştiriliyor. 
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9- Aralara en fazla 8 adet tutamaç ekleyebilirsiniz. (Flash 8’de bu sayı 16’ya 

çıkartılmıştır.) Bunun için tutamacı eklemek istediğiniz noktada renk bandı 

üzerine tıklayınız. Yeni bir tutamaç çıkar. Şekil 3.37’de olduğu gibi üçüncü bir 

tutamaç eklediğinizde şeklinizin son durumu şekil 3.35 (D) görünümünü alır. 

10- İstediğiniz tutamacı kaldırmak için üzerine tıklayınız ve kaydıracın dışına bir 

noktaya sürükleyiniz ve tuşu bırakınız. Kaydıracın yok olduğunu göreceksiniz. 

3.5. Şekilleri Gruplamak 

Uygulama-3.13: Nesnelerin gruplanması ve öncelik sıralamalarının değiştirilmesi 

1- Çalışma sayfasına dış çerçevesi olan bir oval ve bir dörtgen çiziniz. Dörtgeni seçili 

duruma getiriniz ve oval şeklin bir kısmını örtecek şekilde ovalin üzerine getiriniz. 

2- Dörtgeni seçili durumdan kurtarınız. (Çalışma alanında boş bir yere tıklayınız ya 

da Esc tuşuna basın.) Dörtgeni tekrar seçiniz ve başka bir yere sürükleyiniz. Oval 

şeklin dörtgen tarafından örtülen kısmının silindiğini gördünüz mü? (Şekil 3.38) 

 

Şekil 3.38: (A) İki farklı grafik öğesi (B) Sağdaki grafik soldakinin üzerine sürükleniyor. (C) 

Sağdaki grafik seçili durumdan çıkartıldıktan sonra tekrar seçiliyor ve başka bir konuma 

sürükleniyor. Soldaki şeklin örtülen kısmı siliniyor. 

3- Çalışma sayfasına yeni bir grafik öğesi ekleyiniz. Ok aracıyla şeklin üzerine iki 

kere tıklayınız ya da tüm şekli seçecek şekilde grafik öğesini seçim alanı içine 

alınız. 

4- Şeklinizi seçili duruma getirdikten sonra Modify menüsünden Group komutunu 

çalıştırınız ya da Ctrl+G tuşlarına basınız. 

5- Şeklinizin dışında mavi bir çerçevenin oluştuğunu göreceksiniz. Artık tek parça 

halinde kullanabileceğiniz, diğer bir ifadeyle grup altına aldığınız bir nesne elde 

etmiş oldunuz. Çerçeveye çift tıklayınız ve grubun içine giriniz. Grup öğeleri 

seçili duruma gelir. 
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6- Çalışma alanında boş bir yere çift tıklayarak grup moduna geri dönünüz. 

 GRUPLAR: Grafik öğelerini grup altına alarak onlar üzerinde tek parça 
halinde her türlü değişikliği yapabilirsiniz. Taşıyabilir, boyutunu değiştirebilir, döndürebilir 

ve en önemlisi yerleşim sıralarını değiştirebilirsiniz. 1. ve 2. adımlarda gördüğünüz gibi grup 
altına alınmayan şekiller üst üste geldiklerinde birbirlerini keser, şekillerde bozulma 
meydana gelir. 

Grubu çözmek için grubu seçili duruma getirdikten sonra Modify menüsünden 
Ungroup komutunu veriniz. 

7- Çalışma alanına farklı bir şekil çiziniz ve çizdiğiniz bu şekli de grup altına alınız. 

8- Modify menüsünden Arrange komutu altından Send to Back değerini seçiniz. 

9- Çizdiğiniz ikinci şekle tıklayınız ve diğer şeklin üzerine sürükleyin. İkinci şeklin 
ilk şeklin altında kaldığını gördünüz mü? 

10- Çalışma alanına üçüncü bir şekil çiziniz. O şekli de grup altına alınız. Modify 

menüsünden Arrange komutu altından Bring to Front komutunu veriniz. 

11- Çizdiğiniz üçüncü şekli diğer iki şeklin üzerine sürükleyiniz. Üçüncü şeklin en 
üstte, ikinci şeklin en altta, birinci şeklin ortada yer aldığını görürsünüz. 

 

Şekil 3.39: Grupların yerleşim 

sıralarının ayarlanması 

 

Şekil 3.40: Arrange komutu altından grupların 

yerleşim sıralarının değiştirilmesi 
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 Bring to Front: Grubu en öne getirir. 

 Bring Forward: Grubu bir derece öne getirir. 

 Send Backward: Grubu bir derece arkaya atar. 

 Send to Back: Grubu en arkaya atar. 

 Lock: Grubu çalışma sayfasına sabitler. Hareket ettirilemez. Unlock All 
komutuyla tüm kilitli nesneler bu durumdan kurtulur. 

Uygulama-3.14:Grup altına alınan grafik nesnelerinin Alpha değerlerinin 

değiştirilmesi 

Alpha Değeri: Bu değer yardımıyla grafik nesnelerinin saydamlık değerini 
ayarlayabilirsiniz. Böylece nesneler üst üste gelse bile alttaki nesne gözükebilir. 

1- Çalışma sayfasına dolgu renkleri farklı ve katı dolgulu (Solid) iki grafik öğesi 
çiziniz ve grup altına alınız. 

2- Grup altına aldığınız şekillerden birinin öncelik sırasını Modify → Arrange → 

Bring to Front komutuyla en öne getiriniz. 

3- Öne aldığınız şekle iki kere tıklayarak grubun içine giriniz ve dolguyu seçili 
duruma getiriniz. Color Mixer panelinden Alpha değerini %30’a çekiniz. 

4- Çalışma alanında boş bir yere iki kere tıklayınız ve şeklin grup moduna dönmesini 
sağlayınız. 

5- Şekli ok aracıyla tutunuz ve diğer şeklin üzerine getiriniz. Sonuca dikkat ediniz. 

 
Şekil 3.41: (A) Kırmızı dolgulu opak (%100 alpha) görüntülü grafik öğesi (B) Saydam 

görüntünün elde edilmesi 
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3.6. Katmanlar Üzerinde Grafik İşlemleri Gerçekleştirmek 
 

Flash ve benzer grafik yazılımlarının sunduğu en önemli özellik katmanlara ayrılmış 
çalışma sayfaları üzerinde birbirini etkilemeyen grafik öğeleri ve nesnelerle çalışabilmektir. 

Daha önce nesnelerin grup altına alınması (Uygulama-3.13) anlatılırken görüntü öncelikleri 

değiştirilmişti. Böylece grafiklerin birbirlerini etkilemeleri engellenmişti. 
 

Ancak tek bir çalışma alanında çok daha fazla nesne ve grafik öğesinin yer alması 

durumunda bunları organize etmek zorlaşır. Bunu ortadan kaldırmak için çalışma sayfasına 

birden fazla katman ekleme yeteneği geliştirilmiştir. Her bir katman birbirinden bağımsızdır. 

Şimdi sözü fazla uzatmadan uygulamalara geçebiliriz. Katmanların ne olduğunu daha iyi 

anlayacaksınız. 

 

3.6.1 Farklı Katmanlar Oluşturmak 

Uygulama-3.15: Birden fazla katmanın ve katman klasörünün oluşturulması 

1- Boş bir çalışma sayfası açınız. Şekil 3.42’de görüldüğü gibi Timeline panelinde 

Layer 1 adında katman yer alır. 

 
Şekil 3.42: Flash MX’de yeni açılan boş çalışma sayfasının Timeline panelinin ilk görüntüsü 

2- Şekil 3.43’ten yararlanarak yeni katman ekleme butonuna tıklayınız. Layer 2 

isimli yeni bir katman önceki katmanın üstüne eklenecektir. 
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Şekil 3.43: Katmanlar üzerinde işlem gerçekleştiren kısayol butonları 

 

3- Henüz grafik işlemi yapmadığınızdan her iki katmanın birinci karelerinde içi boş 
daire görünmesi gerekir. Layer 1 isimli katmanı seçiniz ve çalışma alanına 

rastgele şekiller çiziniz. 

4- Layer 1 katmanının ilk karesinin içi dolgulu hale gelmiş olması gerekir. 

 
(A) (B) (C) 

 

Şekil 3.44: (A) Layer 1 katmanına grafik öğeleri çiziliyor. (B) Layer 2 katmanına grafik öğeleri 

çiziliyor. (C) Layer 2 katmanı Layer 1 katmanının altına sürükleniyor. 

5- Layer 2 katmanını seçiniz ve ilk katman seçiliyken çizmiş olduğunuz şekillerin 

üzerine gelecek şekilde yeni şekiller çiziniz. 
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6- Şekil 3.44’te görüldüğü gibi katman öğelerinin gizlenmesini ya da görünmesini 

sağlayan göz simgesinin ( ) hizasına gelen noktaya tıklayınız 

(  - noktanın üzerinde kırmızı çarpı işareti belirir) ve 
Layer 2 katmanı öğelerini gizleyiniz. 

7- Üzerinde kırmızı çarpı oluşan noktaya tekrar tıklayınız ve Layer 2 katmanı 
öğelerini görünür kılınız. Layer 2 katman yazısının üzerine tıklayınız ve tuşu 
bırakmadan Layer 1 katmanının altına sürükleyiniz. Daha önce üstte yer alan 
Layer 2 katmanı öğelerinin bu sefer altta kaldığını görmeniz gerekir. 

3.6.2. Katmanlarda Grafik İşlemlerini Yapmak ve Katman Klasörlerini 

Oluşturmak 

Uygulama-3.16:Çok sayıda katman hazırlanması ve ilişkili katmanların ortak 

klasörler altında toplanması 

1- Önceki sayfaları kapatarak yeni bir boş çalışma sayfası açınız. 

2- Layer 1 katmanının üzerine sağ tıklayınız ve çıkan menüden Properties… 
değerini seçiniz. Açılan Layer Properties penceresinde Name değerine grafik 
adını giriniz ve onaylayınız. Katman adının değişmiş olması gerekir. Bu işlemi 
adını değiştirmek istediğiniz katmanın yazısına çift tıklayarak ve istediğiniz bir 
adı yazarak da yapabilirsiniz. 

3- Grafik2 adında ikinci bir katman oluşturunuz. 

4- Grafik katmanını seçiniz ve çalışma alanının sol üst köşesine bir daire çiziniz. 
Dairenin iç dolgusunu seçiniz ve Color Mixer panelinden Radial Gradyent 

uygulayın (gradyent etkileri için Uygulama-3.12’ye göz atınız.) Daireye Arrow 
Tool aracıyla iki kere tıklayıp seçili duruma getiriniz ve sağ tıklayarak çıkan 
menüden Convert to Symbol komutunu veriniz. Çıkan iletişim penceresinde isim 
alanına amblem adını veriniz ve üç durumlu Type isimli tercihten Movie Clip 
değerini seçiniz. 

5- Grafik2 katmanına dış çerçevesi olmayan bir dörtgen çiziniz. 

6- Grafik katmanını seçiniz ve sağ üst köşeye dörtgen çiziniz. Bunu da seçili duruma 
getiriniz ve bayrak adında bir Movie Clip nesnesi olarak ayarlayınız. 

7- Timeline panelinde  simgesine tıklayarak bir katman klasörü oluşturunuz. 
Folder 3 adında bir klasör oluşması gerekir. Üzerine çift tıklayınız ve adını grafik 
grubu diye değiştiriniz. 

8- Grafik katmanına tıklayınız klavyenin Shift tuşuna basılıyken grafik2 katmanına 
da tıklayınız. Her iki katmanın da seçildiğini görmeniz gerekir. Shift tuşunu 
bırakınız ve her iki katman da seçiliyken herhangi birine fareyle tıklayarak grafik 

grubu isimli klasörün üzerine doğru katmanları sürükleyiniz (Şekil 3.45-3.46). 
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Şekil 3.46: Katmanların gizlenmesi ya da görünür 

yapılması 

Şekil 3.45: Katmanların katman klasörü 

içine taşınması 

 

Şekil 3.47: Timeline panelinin son şekli 

9- Grafik grubu katman klasörünü seçiniz ve yeni bir katman ekleyiniz. Eklenen 

yeni katmanın katman klasörü dışında yer alması gerekir. 

10- Eklediğiniz yeni katmana mesaj adını veriniz (Şekil 3.47). Çalışma alanına metin 

aracını kullanarak (Text Tool - A) içinde istediğiniz bir yazının yer aldığı metin 

kutusu ekleyiniz. 

Çok karmaşık ve çok fazla öğenin yer aldığı filmler hazırlarken belli bir konuyla 

ilişkili katmanlarınızı grup altına almanız sizlere büyük kolaylık sağlar.  

 

3.6.3. Kılavuz ve Maske Katmanlarıyla Çalışmak 

Uygulama-3.17: Kılavuz katmanı yardımıyla bir Motion Tween canlandırmasının 

yapılması ve maske katmanının kullanılması. 

1- Yeni bir çalışma sayfası açınız. Layer 1 katmanının adını maske olarak 

değiştiriniz. 

2- Katmanın üzerine sağ tıklayın ve Properties komutuyla Layer Properties 

iletişim penceresini açınız. Type isimli radyo butonlarından oluşan seçme 

menüsünde mask değerini seçiniz ve pencereyi kapatınız. 
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3- İkinci bir katman ekleyiniz. Eklediğiniz Layer 2 isimli katman eğer maske 
katmanının üstünde oluşturulmuşsa üzerine tıklayınız ve maske katmanının altına 
gelecek şekilde sürükleyiniz. 

 

Şekil 3.48: (A) Katmanın maske katmanı olarak ayarlanması (B) maske katmanı altında yeni 

bir katman oluşturulması 

4- Layer 2 katmanın simgesinin Şekil 3.48 (B)’de olduğu gibi değişmesi gerekir. 
Üzerine sağ tıklayarak Properties komutuyla Layer Properties iletişim 
penceresini açınız. Type: menüsünde Masked değerinin seçili olduğunu 
göreceksiniz. 

5- Maske katmanını seçiniz ve üçüncü bir katman ekleyiniz. Layer 3 adını ay adıyla 
değiştiriniz.  (Add Motion Guide) simgesine tıklayınız ve ay katmanının 
üzerinde Guide: ay isimli bir kılavuz katmanı oluşturunuz. 

 

Şekil 3.49: Oluşturulan katmanların Timeline panelindeki dizilimleri bu şekilde olmalıdır 

6- Maske katmanını seçiniz ve şekil 3.50’ye benzer bir şekil çiziniz. Şekli seçiniz ve 
üzerine sağ tıklayarak Convert to Symbol komutunu veriniz. Açılan pencerede 
Name değerine maske adını yazınız. Type tercihi olarak Movie Clip değerini 
seçiniz. 
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Şekil 3.50: Maske katmanında maske olarak kullanılacak grafik öğesinin çizilmesi ve maske 

sembolüne dönüştürülmesi 

7- Maske katmanını seçiniz ve Properties panelinde Tween isimli açılır menüden 

Motion değerini seçiniz. 

8- Maske katmanı hizasındaki zaman çizelgesinde 20. karenin üzerine sağ tıklayınız 

ve Insert Keyframe komutunu vererek anahtar kare eleyiniz. Böylece şeklinizin 

bir kopyasının 20 kare boyunca yer aldığı ve zaman çizelgesinde 1. kareden 20. 

kareye kadar bir ok simgesinin oluştuğu bir doğrusal hareket animasyonu 

hazırlamış oldunuz. 

9- Çizdiğiniz şekli seçiniz ve klavyenin sağ yön tuşuyla bir miktar sağa doğru 

hareket ettiriniz. 

 

Şekil 3.51: maske katmanında bir Motion Tween – Hareket Animasyonu hazırlanması 

10- Maske katmanını  simgesine tıklayarak gizleyiniz ve Layer 2 katmanını 

seçiniz. Şekil 3.52’dekine benzer bir şekil çiziniz ve şekil isminde bir Movie Clip 

sembolüne dönüştürünüz. 
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11- 20. karenin üzerine sağ tıklayıp çıkan menüden Insert Keyframe komutunu 

vererek aynı şeklin 20 kare boyunca yer almasını sağlayınız. 

 

Şekil 3.52: Layer 2 katmanında sekil isimli grafik öğesinin oluşturulması 

12- Ay katmanını seçiniz ve bir hilal çiziniz. Çizimi daha rahat gerçekleştirebilmek 

için diğer katmanların görüntülerini gizleyiniz. Hilali Layer 2 katmanında 

çizdiğiniz şeklin ortasına denk gelecek şekilde çiziniz. 

13- Ay katmanını seçiniz ve Motion Tween oluşturunuz. Çizdiğiniz hilal şeklini 

seçiniz ve sağ tıklayarak Convert to Symbol komutunu veriniz. Hilal isminde 

Movie Clip nesnesine çeviriniz. 20. karenin üzerine sağ tıklayınız ve Insert 

Keyframe komutuyla hilal şeklinin 20. kareye kadar yer almasını sağlayınız. 

Diğer katmanların da içeriklerini görünür duruma getiriniz. 

 

Şekil 3.53: Hilal şeklinin oluşturulması ve Motion Tween canlandırmasının hazırlanması 

14- Maske ve Layer 2 katmanlarının içeriklerini gizleyiniz. Guide: ay katmanını 

seçiniz. Ay katmanında çizilmiş olan hilal şeklinin kılavuz yolunu belirlemek için 

şekil 3.54’tekine benzer bir şekli Pencil Tool aracını kullanarak çiziniz. 
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15- Birinci karede hilal şeklini seçiniz ve şeklin merkezinde gözüken daire şekli 
çizmiş olduğunuz çizginin bir ucuna kenetlenecek şekilde hilal şeklini ayarlayınız 
(Şekil 3.54). 

 

 

Şekil 3.54: Kılavuz yolunun çizilmesi ve 

hilalin kılavuza kenetlenmesi 

Şekil 3.55: Hilalin kılavuzun 

diğer ucuna kenetlenmesi 

16- Guide: ay katmanını seçiniz ve 20. kareye sağ tıklayarak Insert Keyframe 

komutunu veriniz. 20. kare üzerindeyken hilal şeklini seçiniz ve şekil 3.55’te 
gösterildiği gibi hilal şeklini çizginin diğer ucuna kenetleyiniz. 

Kılavuz (Guide) Katmanı Hakkında: Özellikle Motion Tween animasyonu 
yapılırken kullanılır. Belli bir yol boyunca hareket etmesini istediğiniz Movie Clip sembolü 
için hareket yolu çizilir. Sembolünüz bu yol boyunca hareket eder. Modülün Canlandırmalar 
bölümünde daha ayrıntılı olarak bahsedilecektir. 

17- Zaman çizelgesinde o an üzerinde bulunulan karede yer alan kırmızı renkli 
oynatıcı çizgisini seçiniz ve 1.kare ve 20. kare arasında hareket ettiriniz. Hilal 
şeklinin çizilen kılavuz yolu boyunca hareket ettiğinden emin olunuz. 

 
Şekil 3.56: Oynatıcı çizgisi 

Maske (Mask) Katmanı Hakkında: 

Maske katmanında yer alan grafikler, filminiz 
oynatıldığında gözükmez. Maske katmanının amacı 
maskelediği katmanlarda yer alan grafiklerin istenilen 
kısımlarının gösterilmesini sağlamaktır. 

Maske katmanı kullanarak çok hoş etkiler 
yapılabilir. Maske katmanında çizilen grafiğin hizasına 
gelen nesneler gözükür. 

18- Control menüsünden Test Movie komutunu veriniz ve filmi çalıştırınız. Maske 
katmanının içi dolgulu bölgelerine denk gelen Layer 2 katmanındaki şeklin 
gözükmesi gerekir. Aynı zamanda maske katmanı hareket ettiğinden dolayı şeklin 
gözüken kısmının sürekli değişmesi gerekir. 
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ÖĞRENME FAALİYETİ–4 
  

 
Bu öğrenme faaliyetinde Flash’ın esnek metin aracıyla çeşitli metin 

biçimlendirmelerini nasıl yapacağınızı öğreneceksiniz. 

  

 
Metin ve grafik öğeleri arasındaki farkı araştırınız. Örneğin bir kelime işlemci 

yazılımında yazdığınız metinle bir resim editöründe yazdığınız metin arasında ne gibi bir 
farkın olduğunu anlamaya çalışınız. 

 

4. METİN İŞLEMLERİ 
GERÇEKLEŞTİRMEK 

Diğer masaüstü yayıncılık yazılımlarında olduğu gibi Flash’la da metin işlemleri 
yapılabilir. 

4.1. Metinlerle Çalışmak 

Uygulama–4.1: Belgeye metin eklenmesi 

1- Araç kutusundan metin aracını (Text Tool - ) seçiniz. 

 

Şekil 4.1: Çalışma sayfasına metin eklenmesi 

2- Metin aracını seçince çalışma alanının altında yer alan Properties panelinde metin 
aracıyla ilgili nitelikler gözükecektir. Metin türü olarak Static Text seçiniz. 
Çalışma alanına şekil 4.1’de gösterildiği gibi klavyeden bir metin yazınız. Metnin 
etrafında çerçeve oluştuğunu göreceksiniz. 

ÖĞRENME FAALİYETİ–4 

 AMAÇ 

 ARAŞTIRMA 
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Şekil 4.2: Metne hyperlink eklenmesi 

3- Şekil 4.2’de görüldüğü gibi metne hyperlink bağlantısı eklemek için ilgili alana 

bir internet adresi giriniz. 

 Hyperlink hakkında: Durağan metinlere hyperlink bağlantısı ekleyebilirsiniz. 

Böylece Flash filminizi oynatıp fare imlecini bağlantı eklediğiniz metin üzerine 

getirdiğinizde imleç el ( ) şeklini alır. Metin üzerine tıkladığınızda ilgili adrese gidilir. 

Bağlantı eklenmiş metnin altında kesikli çizgi oluşur. Ancak bu çizgi, filminizi 

oynattığınızda gözükmez. 

4- Metni kaplayan kutunun dışına tıkladığınızda metin kutusu kaybolur. Ancak metin 

bir bütündür ve seçildiğinde metin kutusu gözükür. Metnin niteliklerini 

değiştirmek için metni seçili duruma getirmeniz gerekir. 

4.2. Metin Niteliklerini Ayarlamak 

Metin nitelikleri, metnin yazı tipi (Font), boyutu (Size), yazı şekli (Style),  

hizalanması (Align) ve harfleri arasındaki mesafe (Letter Spacing) olarak sıralanabilir. Bu 

nitelikler şekil 4.3’te gösterildiği gibi Text menüsünden ya da şekil 4.1’de gösterildiği gibi 

Properties panelinden değiştirilebilir. 

 

Şekil 4.3: Metin niteliklerinin menü araç çubuğunda yer alan Text menüsü kullanılarak 

ayarlanması 
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Bu niteliklerin dışında Static Text, Dynamic Text ve Input Text olmak üzere üç 

farklı metin türü vardır. Static Text türü durağan metinler yazmak için kullanılır ve kontrol 

edilemez. Dynamic Text ise bir değişken adı olan ve kendisine değer gönderilebilen metin 

türüdür. Input Text ise daha çok elektronik form hazırlanmasında kullanılan ve veri girişi 
için kullanılan, dolayısıyla bir değişken adına sahip olan metin türüdür. 

Flash’ın dâhili ActionScript dili ve değişkenlerle veri türleri anlatılırken Dynamic 

Text ve Input Text metin türleriyle ilgili uygulamalar yapılacaktır. 

Uygulama-4.2: Metin niteliklerinin ayarlanması 

1- Araç çubuğundan metin aracını seçiniz. 

2-  Properties panelinden Static Text metin türünü 

seçiniz. 

3-  Metin tipi olarak Arial yazı tipini seçiniz. 

4-  Metin harfleri arasındaki mesafeyi ayarlayan kaydıracı 15 değerine 

getiriniz. 

5-  Metin boyutunu, rengini, şeklini ve 

hizalanma yönünü ayarlamayı sağlayan değerleri isteğinize göre değiştiriniz. 

6-  Metnin ekranda nasıl görüneceğini ayarlamayı 

sağlayan ve dört farklı seçenekten oluşan görüntü tercihlerinden birini seçiniz. 

7- Çalışma alanına bir metin yazınız. Metnin dışına tıklayın ve araç çubuğundan ok 

aracını (Arrow Tool) seçiniz. Yazdığınız metne tıklayınız. Metin kutusunu 

görmeniz gerekir. Bu durumda metin seçilidir. 

8- Metin seçiliyken yukarıdaki işlem adımlarını farklı değerler için bir kez daha 

uygulayınız. Ctrl+Enter tuş ikilisiyle ya da Control → Test Movie komutuyla 

sonucu izleyiniz. 
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4.3. Metinler Üzerinde Grafik İşlemleri Gerçekleştirmek 
 

Metinler Uygulama-4.1 ve Uygulama-4.2’de görüldüğü gibi bir bütündür ve grafik 

nesnesi değildir. Metinleri grafik nesnesine çevirerek her bir harfi birbirinden bağımsız hale 

getirebilir ve üzerlerinde istediğiniz grafik işlemini yapabilirsiniz. 

Uygulama-4.3: Metinlerin parçalanması ve grafik öğesi haline getirilmesi 

1- Araç kutusundan metin aracını seçiniz. Çalışma alanına istediğiniz bir yazı 

yazınız. 

2- Metni seçiniz ve Modify menüsünden Break Apart (Parçalarına Ayır) komutunu 

uygulayınız ya da Ctrl+B tuşlarına basınız. 

3- Bir bütün olan metin harflerine ayrılır ve her bir harf birbirinden bağımsızdır. 

Tekrar Break Apart komutunu uygulayınız. 

(A) 

(B) 

(C) 
 

Şekil 4.4: (A) Bütün metin grubu. (B) Break Apart komutu uygulanmış metin grubu. Artık her 
bir harf bağımsız. (C) Break Apart komutu ikinci kez uygulanıyor. Artık yazı metin özelliğini 

kaybediyor. 

4- Break Apart komutuyla parçalara ayırdığınız yazı metin özelliğini kaybetmiş 
olduğundan her bir harf üzerinde istediğiniz grafik işlemini yapabilirsiniz.  

 

İpucu : Break Apart komutuyla grup altına alınmış tüm grafikleri öğelerine 

ayırabilirsiniz. 

 



 

 62

4.4. Dinamik Metinlerle Çalışmak 

Dinamik metinler, kendilerine değer gönderilebilen metin kutularıdır. Çalışma 
alanının herhangi bir noktasına dinamik metin türünde metin kutusu eklediğinizde ve içine 
hiçbir şey yazmadığınızda metin kutusu kesik çizgilerle gösterilir. İçine başka bir yerden 
değer gönderebilirsiniz ya da kendisine daha önceden gönderilmiş değeri okuyabilirsiniz. 

Dinamik metin kutularıyla çalışmanın yolu değişken olarak adlandırılan, çeşitli türden 
verileri tutmayı sağlayan değerleri kullanmaktır. Örnek vermek gerekirse bir nüfus kimliğini 
ele alalım: 

Nüfus kimlğinde; Kimlik Nu, Soyadı, Adı vb. başlıklar vardır. Bu başlıkları değişken 
olarak adlandırırsak bu değişkenlere girilen bilgiler de veri olur. Zaten değişken kelimesi 
duruma göre sakladığı veri değişen anlamına gelmektedir. Dinamik metin kutularının bir 
değişken adı olmalıdır ki, bu değişken adına atıfta bulunarak değer gönderebilelim. 

 

İpucu : Bilgisayar programcılığı konusundaki tecrübelerinizden yararlanarak 
değişken adı verilirken dikkat edilmesi gereken kuralları hatırlamaya çalışınız. 

 

Uygulama-4.4: Flash bileşenlerinden (components) radyo butonlarına duyarlı 

dinamik metin kutusunun hazırlanması 

1- Boş bir çalışma sayfası açınız. 

2- Timeline panelinde yer alan  - Insert Layer simgesine tıklayarak yeni bir 
katman ekleyiniz. 

3- Eklenen katmana iki kere tıklayınız ve Layer 2 adını siliniz, katman adı olarak 
Kontrol Katmanı yazınız. 

4- Layer 1 katmanına iki kere tıklayınız ve katmana mesaj adını veriniz. 

5- Eylem adında yeni bir katman daha ekleyiniz. 

6- Eylem katmanı seçiliyken Window menüsünden Actions komutuyla ya da F9 

tuşuyla Actions-Eylemler penceresini açınız. 

7- Pencerede şekil 4.5’te gösterilen simgeyi bulunuz ve tıklayarak açılan menüden 
Expert Mode değerini seçiniz. 

 Kod Yazım Modları Hakkında: Flash’ta iki tür kod yazım modu vardır. 
Actions penceresi iki ana bölümden oluşur. Sol tarafta Flash tarafından kullanılan kodların 
bir listesinin yer aldığı bölüm, sağ taraftaysa kodların yazıldığı bölüm vardır. Eğer 
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yazacağınız kodları ezbere bilmiyorsanız sol taraftaki bölümden yararlanarak ilgili kodu 

seçebilir ve sağ tarafa yerleştirebilirsiniz. Bu kod yazımı Normal Mode olarak adlandırılır. 

Diğer kod yazım modundaysa (Expert Mode) kodlar ezbere yazılır. Flash 8’de Normal ve 

Expert kod yazım modlarına geçmek için  düğmesi kullanılmaktadır. 

 
Şekil 4.5: ActionScript kodunun yazılması için Expert Mode modunun seçilmesi 

 
8- Şekil 4.6’da gösterilen ActionScript kod yazım alanına tek satırdan oluşan işaretli 

kodu dikkatlice yazınız. 

 
Şekil 4.6: Eylem katmanına ActionScript kodunun yazılması 

9- Actions penceresini kapatınız. Kontrol Katmanı katmanına tıklayınız ve seçili 

duruma getiriniz. 

10- Components panelinden RadioButton bileşenini bulunuz. Tıklayınız ve 

sürükleyerek çalışma alanına bu bileşenden ekleyiniz. Aynı şekilde üç tane daha 

radyo butonu ekleyiniz (Şekil 4.7). 

 

 

Şekil 4.7: Çalışma alanına dört adet radyo butonunun 

eklenmesi 

Şekil 4.8: Radyo butonu 

değerlerinin değiştirilmesi 
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11- Radyo düğmelerinden birini seçili duruma getiriniz ve Properties paneline 

giderek aşağıdaki değişiklikleri yapınız (Şekil 4.8): 

Label alanına tıklayınız ve Galatasaray yazınız. 

Initial State alanına tıklayınız ve açılır listeden true değerini seçiniz. 

Group Name alanına takim yazınız. 

Data alanına GALATASARAY yazınız. 

12-  Diğer radyo düğmelerine sırasıyla aşağıdaki değerleri giriniz: 

Label alanına Fenerbahçe, Trabzon ve Beşiktaş, 

Group Name alanına takim (bütün radyo butonlarına), 

Data alanına FENERBAHÇE’, TRABZON’, BEŞİKTAŞ yazılarını yazınız. 

Galatasaray düğmesi dışında diğer butonların Initial State değeri false olacak. 

13- Mesaj katmanını seçiniz ve çalışma alanına yeterince geniş içi boş bir metin 

kutusu ekleyiniz. Şekil 4.9’da gösterildiği gibi Properties panelinden Dynamic 

Text değerini seçiniz. Var: kısmına mesaj yazınız. 

 

Şekil 4.9: Metnin dinamik metin olarak ayarlanması 

14- Mesaj katmanına isterseniz içinde Hangi Takımı Tutuyorsunuz? yazılı statik bir 

metin kutusu ekleyebilirsiniz. 

15- Kontrol Katmanında yer alan Fenerbahçe düğmesini seçiniz ve Actions 

penceresini açın. Aşağıdaki kod satırlarını Expert Mode yazım modunda yazınız. 

on(press){ 

_root.mesaj = "ŞAMPİYON " + this.getData(); 

} 

16- 14. adımı diğer radyo düğmeleri için de uygulayınız. 
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17- Control menüsünden Test Movie komutunu vererek hazırladığınız Flash filmini 

çalıştırınız. Seçtiğiniz değere göre mesaj yazdıran bir canlandırmanın (animasyon) 

ekranı gelmesi gerekir. Eğer böyle bir sonuç almıyor ya da karşınıza hata mesajı 

geliyorsa yukarıdaki adımları gözden geçiriniz. 

 
Şekil 4.10: Seçilen değerlere göre elde edilen ekran çıktıları 

 
Şekil 4.11: Hazırlanan canlandırmanın bitmiş tasarım görüntüsü 

Uygulama Hakkında: 4.4 nu.lı uygulamayla üç katmanlı bir film hazırlandı. Göz 

( ) simgesinin hizasına karşılık gelen noktaya tıklayarak görünen katmanı gizleyebilir, 

gizli katmanı da görünür yapabilirsiniz. Kilit ( ) simgesinin hizasına karşılık gelen noktaya 

tıklayarak seçili katmanı üzerinde değişiklik yapılamayacak duruma getirebilirsiniz. 
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4.4 nu.lı uygulama, dört adet radyo düğmesi yardımıyla ekranın istenen yerinde yazı 

yazdıran bir canlandırmadır. 

Eylem katmanı içinde, canlandırma ilk çalıştırıldığı zaman hangi radyo düğmesi 

varsayılan olarak seçiliyse o radyo düğmesinin Data değerini ŞAMPİYON kelimesine 

ekleyen bir kod vardır. Böylece canlandırmanın ilk durumu denetlenmektedir. 

Ekrana yazdırılan mesaj da ayrı bir katmana yerleştirilmiştir. Bu katmana kontrol 

edilecek başka elemanlar da yerleştirileceği zaman Kontrol Katmanı gizlenebilir ve katman 

üzerinde daha rahat işlem yapılabilir. 

İpucu : Eğer katmanlarınıza ActonScript diliyle eylem yerleştirecekseniz bunu 

ayrı bir katmanda yapmanız yerinde olur. Böylece çok büyük canlandırmalarla 

uğraştığınızda üzerinde değişiklik yapmak istediğiniz katmanı rahatlıkla 

bulabilirsiniz. 
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ÖĞRENME FAALİYETİ–5 
  

  

Bu öğrenme faaliyetinde sembol oluşturmayı, farklarını ve kütüphaneden hazır 

sembollerin çağrılmasını öğreneceksiniz. 

  

 
Bir nesnenin örneğini oluşturma kavramını araştırınız. Bir programda yapılan 

çalışmaların o programın kütüphanesine eklenmesinin üstünlüklerini tartışınız. İnternette 

araştırma yaparak Flash’la hazırlanmış çeşitli buton örnekleri toplamaya çalışınız. Elde 

ettiğiniz sonuçları sınıf arakadaşlarınızla paylaşınız. 

 

5. SEMBOLLERİ KULLANMAK 
Flash’ın önemli özelliklerinden biri de çizilen grafikleri ve nesneleri sembol olarak 

oluşturabilmektir. Flash’ta Movie Clip, Button ve Graphic olmak üzere üç tür sembol 

vardır. 

Semboller birden fazla kullanılabilen nesnelerdir. Sembole dönüştürülen bir nesne 

Flash kütüphanesine eklenir. Sembol kullanılmak istendiğinde kütüphaneden çağrılır ve bir 

örneği oluşturulur.  

Bu durumu şu şekilde açıklayabiliriz; Bir otomobil fabrikası düşününüz. Bu fabrikada 

kaportayı üretmek için daha önceden hazırlanmış bir kalıbın olduğunu varsayınız. Her yeni 

kaporta üretilmek istendiğinde ilgili kalıp kullanılarak yeni kaportalar hazırlanır. Böylece 

ilgili kalıptan yeni kaporta örnekleri elde edilmiş olur. 

5.1. Grafik Sembolleri Oluşturmak 

Grafik sembolleri; yazılımsal olarak kontrol edilemeyen, hareketli ya da durağan 

grafiklerden oluşabilen nesnelerdir. 

Uygulama-5.1: Grafik sembolü oluşturmak 

1- Boş çalışma sayfası açınız ve çalışma sayfasına çeşitli şekiller ekleyiniz. 

2- Eklediğiniz şekilleri seçiniz ve Modify → Convert to Symbol komutuyla ya da 

F8 tuşuyla sembol dönüşüm penceresini ekrana getiriniz. 

3- İstediğiniz bir sembol ismi yazınız. 

4- Sembol türü olarak Graphic değerini seçiniz. İşlemi onayladıktan sonra seçtiğiniz 

şekillerin kapalı bir çerçeve içine alındığını görmeniz gerekir. 

ÖĞRENME FAALİYETİ–5 

 AMAÇ 

 ARAŞTIRMA 
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Şekil 5.1: Sembollerin kütüphane 

penceresinden izlenmesi 

Semboller ihtiyaç duyuldukça kullanılabilir. 

Oluşturduğunuz sembol otomatik olarak çalışma 

sayfanızın kütüphanesine kaydedilmiştir. Artık aynı 

isimde başka bir sembol oluşturamazsınız. 

Oluşturduğunuz sembolün bir örneğini çalışma 

sayfasına eklemek istiyorsanız Window

menüsünden Library değerini seçiniz ve kütüphane 

penceresini açınız. Şekil 5.1’de görüldüğü gibi 

filminize eklenen semboller kütüphane penceresinde 

gösterilir. Listeden hangi sembolü seçerseniz 

önizlemesi aynı pencerede gösterilir. 

Listeden istediğiniz sembolü seçip çalışma 

alanına sürükleyecek olursanız sembolün yeni bir 

kopyasını elde etmiş olursunuz. 

 

5.2. Movie Clip Sembolleri Oluşturmak 

Uygulama-5.2: Nesnelerin Movie Clip sembolleri olarak ayarlanması 

Movie Clip: Modülün başında Flash’ın ActionScript programlama dili 

yardımıyla kullanıcı tepkisine duyarlı canlandırmaların hazırlanabileceği belirtilmişti. Uygun 

programcılık teknikleriyle Flash’ta çizilmiş grafik öğelerini düzenlemek (konumlarını, 

boyutlarını, renklerini değiştirmek, vb.) mümkündür. Modülün ilerleyen bölümlerinde 

ActionScript dilinin kullanımından uygulamalı olarak bahsedilecektir. 

Düzenlenecek bir grafik öğesinin instance name (örnek ad) alabilmesi ve Motion 

Tween olarak adlandırılan hareket canlandırmalarının hazırlanabilmesi için; ilgili grafik 

öğesinin Movie Clip nesnesi olarak ayarlanması gerekir. 

1- Yeni bir Flash dosyası açınız ve Modify → Document… komutunu çalıştırınız. 

Document Properties iletişim penceresinde Background Color (Zemin Rengi) 

renk değerini gri tona ayarlayınız ve OK komutuyla pencereyi kapatınız. 

2- Çalışma alanına Türk Bayrağı ayından çiziniz. Ayrı bir yere de beş köşeli yıldız 

çiziniz. Yine ayrı bir yere ayı ve yıldızı içine alacak büyüklükte bir dikdörtgen 

çiziniz. 

3- Ayı seçili duruma getiriniz ve Modify menüsünden Convert to Symbol 

komutunu veriniz ya da F8 tuşuna basınız. Çıkan iletişim penceresinde Name 

(İsim) yazan kısma Ay adını giriniz. Type (Tür) tercihi olarak Movie Clip 

değerini seçiniz. 
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Şekil 5.2: Grafik öğesinin Movie Clip nesnesine dönüştürülmesi 

4- Aynı şekilde yıldızı da seçiniz ve Yıldız adında bir Movie Clip nesnesine 

dönüştürünüz. Dörtgeni de seçiniz ve Zemin adında bir Movie Clip nesnesine 

dönüştürünüz. 

5- Nesnelerin içine çift tıklayarak girebilir ve gerekli grafik düzenlemelerini 

yapabilirsiniz. Zemin nesnesinin görüntü sıralamasını Send to Back komutuyla 

en arkaya atınız. Böylece Ay ve Yıldız nesneleriniz bayrağın zemini üzerine 

çıkmış olur. 

 

Şekil 5.3: Movie Clip nesnelerine çevrilmiş grafik öğeleri 

6- Ay Movie Clip nesnesini seçiniz ve Properties paneline dikkat ediniz. 

7- Nesnenize çeşitli yöntemlerle kontrol edilebilmesi için <Instance Name> yazan 

yere bir örnek adı girmeniz gerekir. Buraya gireceğiniz isim içinde boşluk 

karakteri ve noktalama işaretleri olmamasına dikkat ediniz. Daha önce Movie Clip 

adı olarak vermiş olduğunuz adı da eğer kurallara uygunsa instance adı olarak 

kullanabilirsiniz. 

8- <Instance Name> kısmına ay adını giriniz. Böylece ilerde komuta edebileceğiniz 

bir Movie Clip nesnesi hazırlamış oldunuz. 



 

 72

 
Şekil 5.4: Movie Clip nesnesine instance (örnek) adı verilmesi 

5.3. Düğmelerle Çalışmak 

Flash’ın kullanıcılara ve özellikle web tasarımcılarına sunduğu önemli özelliklerden 

biri de etkileşimli, üç boyut (3-D) etkisine sahip düğmelerin hazırlanmasıdır. Flash’la düğme 

hazırlamak oldukça kolaydır. 

Görsel yeteneğinizin ve sanatsal bakış açınızın güçlü olması durumunda, birazcık da 

ince bir işçilikle görsel çekim gücü yüksek olan tasarımlar yapmanız mümkündür. Bu 

bölümde Flash’ın hazır düğmelerini nasıl kullanacağınız ve kendi düğmelerinizi nasıl 

hazırlayacağınız anlatılacaktır. 

5.3.1. Flash Düğmelerini Kullanmak 

Flash kullanıcılara pek çok kolaylık sağlar. Kütüphanesinde yer alan hazır düğmeler 

yardımıyla işlerinizi kolaylaştırmanız söz konusudur. Böylece zaman kaybetmeden Flash’ın 

sunduğu hazır düğmeleri kullanabilir. 

Uygulama-5.3: Flash kütüphanesinden hazır butonların seçilmesi ve kullanılması 

1- Windows menüsünden Common Libraries komutuyla flash nesne kütüphanesine 

ulaşınız. Çıkan menüden Buttons’u seçiniz. 

  
Şekil 5.5: Falash’ın buton kütüphanesi Şekil 5.6: Simgelerin anlamı 
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2- Düğme gruplarının yer aldığı bölümden istediğiniz bir grubun üzerine sağ tuşla 

tıklayınız. Expand Folder ve Expand All Folders seçeneklerinin seçilebilir 

olduklarını görmeniz gerekir. Expand All Folders’ı seçiniz. 

3- Tüm grupların altında yer alan düğmelerin listesi açılır. Pencere içerisine 

sığmadıklarından dolayı dikey kaydırma çubuğu aktif olur. Aşağı doğru 

ilerleyerek ne tür düğmeler olduğunu ön izleme alanından görünüz. Component 

button assets grubundan button isimli butonu seçiniz. 

Butonların üzerine fare imleci geldiğinde imleç el ( ) şeklini alır. Düğme 

grupları arasında yer alan Movie Clip nesnelerininse böyle bir özelliği yoktur. 

Ancak düğme listesinde yer alan Movie Clip nesnelerini düğme yaparken 

kullanabilirsiniz. 

4- Fareyle çalışma alanına doğru sürükleyiniz. Aynı düğmenin bir örneğinden 

çalışma sayfasına istediğiniz kadar alabilirsiniz. Çalışma sayfasına eklediğiniz 

düğmeyi silebilirsiniz. Silme işleminin kütüphanede yer alan örneğine bir etkisi 

olmaz. 

5- Filminizi çalıştırdığınızda çıkan Flash Player ekranında fareyle düğmenin üzerine 

geldiğinizde, imlecin el ( ) şeklini aldığını göreceksiniz. 

6- Oynatıcıyı kapatıp çalışma alanına dönünüz. Düğmenizin bu durumuyla hiçbir işe 

yaramadığını görmüş olmalısınız. Bu nedenle düğmeye bir eylem eklenmesi 

gerekir. 

7- Düğmeyi seçiniz. Window menüsünden Actions komutunu seçiniz. Açılan eylem 

penceresinde Normal Mode kod yazım modunu onaylayınız. 

 

Şekil 5.7: Normanl Mode kod 

yazımı 

Şekil 5.8: On buton eyleminin seçilmesi 

8- Sol taraftaki listeden Actions değerini seçiniz. Movie Control menüsünü seçiniz 

ve çıkan listeden on değerine iki kere tıklayınız. 
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9- Event: kısmındaki seçme kutularından yalnızca Release değerini seçiniz (Şekil 

5.8). on (release) satırı seçili durumda kalsın. 

10- Sol taraftaki listeden Objects değerini ve açılan listeden Movie değerini seçiniz. 

Listeden Movie Clip değerini ve yine açılır listeden Methods menüsünü seçiniz. 

nextFrame değerini bulunuz ve iki kere tıklayarak şekil 5.9’da olduğu gibi 

komutu on (release) { satırının altına yerleştiriniz. 

 

Şekil 5.9: Normal Mode kod yazım modunda çalışılması 

11-  <not set yet> kısmına bir değer yazılması gerekir. Çalışma sayfamız, kök dizin 

olduğundan çalışma sayfasında bir sonraki kareye gitmeyi sağlamak için Object: 

yazılı alana _root değerini yazınız. 

12- Eylem penceresini kapatınız. Kodunuzun aşağıdaki gibi olması gerekir. 

on (release) { 

  _root.nextFrame(); 

} 

13- Timeline panelinde birinci karenin yanındaki kareyi (2.kare) seçiniz. Sağ 
tıklayınız ve çıkan menüden Insert Keyframe komutunu veriniz. Aynı düğmeden 

çalışma sayfasının ikinci karesine de yerleştirildiğini görmeniz gerekir. 

14- İkinci karedeki düğmeyi seçiniz ve eylem penceresini açınız. Expert Mode yazım 

moduna dönünüz. Düğme içindeki kodu görebilmeniz için eylem penceresinin 

üstünde yer alan açılır menüden Actions for [No instance name assigned] 

(button) değerini seçiniz. 

15- 2. satırdaki _root.nextFrame() değerini _root.prevFrame() değeriyle değiştiriniz. 

16- 1. kareye gidiniz ve metin aracını seçerek Sayfa-1 yazınız. İkinci kareye giderek 

Sayfa-2 yazınız. 
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17- 1.kareyi yine seçiniz ve eylem penceresini açınız stop() kodunu yazınız. 

18- Filminizi çalıştırınız ve butonlara tıklayarak sonucu görünüz. 

ActionScript Kodları Hakkında: Filminizin ilk karesine yerleştirdiğiniz 

stop() komutu filminiz oynatılmaya başladığında kontrol dışı hareket etmesini engeller. Bu 

kodu koymayacak olursanız filminiz 1. ve 2. kareler arasında sürekli oynamaya devam eder. 

on deyimi, düğmelerde kullanılan ve fare hareketine ya da bazı klavye tuşlarına 

duyarlı eylem yöneticisidir. Programcılık konusunda bilginiz varsa fonksiyonları da 

bilirsiniz. Bir bakıma fonksiyon başlığıdır ve yalnızca düğmelerde kullanılır. on deyimini 

yazıp parantez açtığınızda bu deyimle birlikte kullanabileceğiniz fonksiyonların listesi 

karşınıza çıkar. 

5.3.2. Yeni Düğme Hazırlamak ve Film Kütüphanesine Eklemek 

Uygulama-5.4: 3-D görünümlü buton hazırlanması 

1- Çalışma alanına 50x50 px boyutlarında kırmızı dolgulu çerçevesi olmayan bir 

daire çiziniz. Color Mixer panelinde Radial gradyent etkisini seçiniz. Birinci 

tutamacın rengini kırmızıya, ikinci tutamacın rengini griye ayarlayınız. 

2- Daireyi seçiniz ve farenin sağ tuşuna tıklayıp çıkan menüden Convert to Symbol 

komutuyla sembol dönüştürme iletişim penceresini açınız. Name-İsim: olarak 

butonum ismini giriniz. Type: özelliği olarak Button değerini seçiniz. 

3- Şekliniz sembole dönüştükten sonra çift tıklayarak içine giriniz. Şekil 5.10 gibi bir 

zaman çizelgesi görmeniz gerekir. 

 

 

Şekil 5.10: Dört film karesinden oluşan buton 
Şekil 5.11: Butonun aldığı 

şekiller 

Butonlar Hakkında: Butonlar dört film karesinden oluşur. Bu karelerin 

anlamı aşağıdaki gibidir: 

Up: Bu kareye çizilen şekil düğmenin ilk görünen şeklidir. 

Over: Fare imleci düğme üzerine geldiğinde gözükecek şekil buraya çizilir. 
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Down: Fare imleci düğme üzerindeyken tıklandığında düğmenin alacağı şekil buraya 
çizilir. 

Hit: Düğmenin vuruş alanıdır. Buraya çizdiğiniz şekil önemli değildir. Ancak buraya 
butonunuzun kapladığı alan kadar bir şekil çizmeye çalışınız. Düğmenin etki alanı ve fare 

imleci düğmenin üzerine geldiğinde imlecin el ( )  şekli almasını sağlayacak yüzey alanı 
bu kare yardımıyla belirlenir. 

4- Over karesini seçiniz, sağ tıklayınız ve Insert Keyframe komutunu veriniz. Aynı 
işlemi Down ve Hit kareleri için de yapın. 

5- Down karesini seçiniz ve Radial gradyent etkisi uygulayınız. Bu sefer ikinci 
tutamacın rengini beyaza ayarlayınız. 

6- Filminizi oynatınız. Düğmenize üç boyut etkisini kazandırmak grafik öğelerini iyi 
kullanabilme yeteneğinize kalmıştır. 

7- Window menüsünden Library seçeneğini seçiniz ya da F11 tuşuna basınız. 
Ekrana, üzerinde çalıştığınız çalışma sayfasında yer alan nesneleri gösteren bir 
pencere gelir. Çalışma sayfasındaki nesneleri silseniz bile kütüphanede (Library) 
bu nesneler saklanır. Listeden kullanmak istediğiniz nesneyi seçip çalışma alanına 
doğru sürükleyiniz. Bu şekilde bir nesnenin sayısız örneğini oluşturabilirsiniz. 

5.3.3. Flash Düğmeleri Üzerinde Değişiklik Yapmak 

Uygulama-5.5: Flash düğmeleri üzerinde değişiklik yapılması 

1- Window menüsünden Common Libraries seçeneği altından Buttons değerini 
seçiniz ve çıkan buton klasörleri listesinden button assets klasörünü Expand 
Folder komutuyla açınız. 

2- Button isimli düğmeyi seçiniz ve çalışma alanına sürükleyiniz. 

3- Üzerine çift tıklayıp içine giriniz. Çok sayıda katmandan oluştuğunu görmeniz 
gerekir. 

4- Kilit simgesini tıklayarak düğme üzerinde değişiklik yapılabilmesini sağlayınız. 

İstediğiniz katmanın istediğiniz karesinde her türlü değişiklik yapabilirsiniz. Ancak bu 
değişiklikler kalıcı duruma gelmez. Çalışma alanını kapadığınızda üzerinde değişiklik 
yaptığınız buton eski durumuna gelir. 
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Şekil 5.12: Flash butonları üzerinde değişiklik yapılması. Butonun gradients katmanı seçili 

durumdadır 

Üzerinde değişiklik yaptığınız düğmeden bir tane daha eklemek istediğinizde ekrana 
Resolve Library Conflict hata penceresi gelir. Don’t replace existing items değerini 
seçerseniz yaptığınız değişiklik, eklediğiniz düğme için de geçerli olur. Replace existing 

items değerini seçerseniz yaptığınız değişiklik etkisini kaybeder. 



 

 82

Doğrusal ve kılavuz yoluyla olmak üzere iki tür hareket canlandırması vardır. Hareket 

canlandırmalarında şeklin fiziksel görüntüsünde bir değişiklik olmaz. Yalnızca belli bir yol 

boyunca hareket eder. Eğer canlandırmanızı play() – oynat ve stop() – durdur deyimleriyle 

denetlemeyecek olursanız canlandırma geldiği son kareden tekrar ilk kareye döner ve süreç 

sürekli devam eder. 

6.1.1. Doğrusal Motion Tween Hazırlamak ve Hareketleri Yumuşatmak 

Uygulama-6.1: Doğrusal hareket canlandırması hazırlanması 

1- Boş bir çalışma sayfası açınız. Çalışma alanının dışındaki iki yana şekil 5.1’deki 

gibi yazılar yazınız.  

 

Şekil 6.1: Yazıların çalışma alanı dışına eklenmesi 

2- Yazılardan birini seçiniz ve Insert menüsünden (Flash 8 için Modify menüsü) 

Convert to Symbol komutunu vererek yazi1 adında Movie Clip sembolüne 

dönüştürünüz. Diğer yazıyı da seçiniz ve onu da yazi2 adında Movie Clip 

sembolüne dönüştürünüz. 

3- yazi1 nesnesi üzerine çift tıklayarak içine giriniz. Insert menüsünden Create 

Motion Tween komutunu veriniz (Flash 8 için Insert → Timeline → Create 

Motion Tween). Metin kutusu otomatik olarak Tween 1 adında bir sembole 

dönüşür. 

4- yazi2 nesnesi için 3. adımı tekrarlayınız. 

5- Window menüsünden Library komutunu veriniz. O ana kadar çalışma sayfanıza 

eklediğiniz nesnelerin bir listesi karşınıza gelir. 

6- yazi1 nesnesinin içine girerek 20. karenin üzerine sağ tıklayınız ve Insert 

Keyframe komutunu veriniz. yazi1 nesnesinin bir kopyasının 20 kareye de 

yerleştirildiğini göreceksiniz. 20. karedeki yazı 1 nesnesini seçiniz ve klavyenin 

yön tuşuyla çalışma sayfasının diğer tarafına doğru sürükleyiniz. 

7- yazi2 nesnesinin içine girerek 20.karenin üzerine sağ tıklayınız ve Insert 

Keyframe komutunu veriniz. 20. karedeki yazi2 nesnesini seçiniz ve klavyenin 

yön tuşuyla çalışma sayfasının diğer tarafına doğru sürükleyiniz. 
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Şekil 6.2: yazi1 ve yazi2 nesnelerinin bitiş noktalarının belirlenmesi 

8- Böylece yazi1 ve yazi2 nesneleri içinde birbirinden bağımsız hareket 

canlandırması hazırlamış olduk. yazi1 ya da yazi2 içine girip 1. ve 20. kare 

arasındaki karelere bakabilirsiniz. Hareketin nasıl gerçekleştiğine dikkat ediniz. 

Ara kareler, Flash tarafından otomatik olarak doldurulmuştur. 

9- Hazırladığınız çalışmayı Control → Test Movie komutuyla deneyiniz. 

Uygulama-6.2:Doğrusal hareket canlandırmalarında hareket yönlerinin 

değiştirilmesi 

Flash’ın otomatik olarak doldurduğu ara karelere müdahalede bulunup ara hareketleri 

değiştirmek mümkündür. 

1- Yeni bir çalışma sayfası açınız ve çalışma alanına bir şekil çiziniz. 

2- Çizdiğiniz şekli seçiniz ve Insert → Create Motion Tween komutuyla hareket 

canlandırması oluşturunuz (Flash 8 için Insert → Timeline → Create Motion 

Tween). 

3- Daha önceki uygulamadan farklı olarak bu uygulamada bütün çalışma sayfası 

hareket canlandırmasına ayrılır. Çalışma alanına yeni bir grafik öğesi ekleyiniz. 

25. kareye sağ tıklayınız ve Insert Keyframe komutunu veriniz. 
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Şekil 6.3: 1. ve 25. kareler 

4- 1. kareye eklediğiniz şekil hareket canlandırmasının dışında kaldığı için şekil 

6.3’te gözüken bozulma meydana gelir. Hareket canlandırmasını belirten ok 

simgesi zaman çizelgesinde gözükmemektedir. Onun yerine canlandırmada bir 

hata olduğunu belirten kesikli çizgiler vardır. Sonradan çizdiğiniz şekli silgi 

aracının Faucet yardımcı aracıyla siliniz. 

5- Şekil tamamen silindiğinde ok simgesinin 1. kareden 25. kareye kadar oluştuğunu 

görmelisiniz. 

 

Şekil 6.4: (A) Zaman çizelgesinin alması gereken şekli. (B) Ara anahtar kare eklenmesi 

6- 25. kareye gidiniz ve movie clip nesnenizi farklı bir yere taşıyınız (Şekil 6.4-A-). 

7- 10. kareye gidiniz ve sağ tıklayarak Insert Keyframe komutunu veriniz. Okun iki 

ayrı ok olarak bölündüğünü görmeniz gerekir (Şekil 6.4-B-). 

8- 10. karedeki şekli başka bir yere sürükleyiniz ve canlandırmanızı çalıştırıp farka 

dikkat ediniz. 
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Hareket canlandırmalarında Flash tarafından oluşturulan karelere müdahale edip 

daha yumuşak geçişli hareketler elde edebilirsiniz ya da her bir hareket için ayrı 

ayrı motion tween yapmaya gerek kalmadan araya anahtar kare ekleme 

yöntemiyle çok sayıda farklı hareketi tek bir canlandırmayla yapabilirsiniz. 

 

6.1.2. Kılavuz Yoluyla Motion Tween Hazırlamak 

Uygulama-6.3: Kılavuz katmanıyla uçan kelebek canlandırmasının oluşturulması 

1- Yeni bir çalışma sayfası açınız ve bir kelebek şekli çiziniz ya da ekleyiniz. 

2- Insert → Create Motion Tween komutuyla (Flash 8 için Insert → Timeline → 

Create Motion Tween) hareket canlandırması oluşturunuz. 

3- Add Motion Guide -  simgesine tıklayarak Layer 1 katmanının üzerinde bir 

hareket kılavuzu katmanı oluşturunuz. 

4- Şeklinizin nasıl bir yol boyunca hareket etmesini istiyorsanız Pencil Tool aracıyla 

ona uygun bir yol çiziniz. 

5- Motion tween nesnesine dönüşen şeklinize tıklayınız. Büyük olasılıkla şekliniz 

çizmiş olduğunuz kılavuz yolunun bir ucuna kenetlenecektir. Kenetlenme olmazsa 

şekli seçiniz ve kılavuz çizgisinin bir ucuna sürükleyiniz. 

 

Şekil 6.5: Şeklin hareket kılavuzuna kenetlenmesi 

6- Layer 1 katmanında 20. kareye sağ tıklayın ve bir anahtar kare (Insert 

Keyframe) ekleyiniz. 

7- Kılavuz katmanının hizasına gelen 20. kareye sağ tıklayın ve bir anahtar kare 

(Insert Keyframe)  ekleyiniz. 

8- Layer 1 katmanının 20. karesini seçiniz ve şekli kılavuz çizgisinin diğer ucuna 

klavye yön tuşlarıyla sürükleyiniz ya da fareyle taşıyınız. 
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Şekil 6.6: Şeklin kılavuz çizgisinin diğer ucuna kenetlenmesi 

9- Canlandırmanızı çalıştırınız. Kelebeğinizin gerçek bir kelebek esnekliğinde 

hareket etmediğini göreceksiniz. 

10- Şeklin yönünü çevirmek suretiyle daha yumuşak ve gerçekçi bir hareket elde 

edebiliriz. Bunun için bazı yerlerde ara anahtar kareler ekleyip şekli döndürmek 

gerkecektir. Şekil 6.7’de gösterildiği gibi ara kareler ekleyiniz ve şeklinizi Rotate 

komutuyla gerek gördüğünüz yerlerde döndürünüz. Filminizi kaydediniz. 

 

Şekil 6.7: Ara kareler ekleyerek hareketin daha gerçekçi yapılması 
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6.2. Şekil Canlandırmaları (Shape Tween)Hazırlamak 

Şu ana kadar yapılan canlandırmalar nesnelerin hareketlendirilmesi şeklindeydi. Flash 

bunun yanında Shape Tween denen canlandırma yardımıyla şekillerin görüntülerinde de 

değişiklik yapılmasına imkân sağlar. 

Uygulama–6.4:Düğmelerle denetlenen shapetween canlandırmasının hazırlanması 

1- 300 px genişliğinde ve 200 px yüksekliğinde yeni bir Flash sayfası açınız. 

2- Çalışma alanının ortasına 100X100 px boyutlarında bir daire çiziniz. 

3- Daireyi seçiniz ve “shapetwen” adında movie clip sembolüne dönüştürünüz. 

Movie clip sembolüne dönüşen nesnenize çift tıklayınız ve içine giriniz. 

4- Katmanı seçiniz ve Properties panelinde Tween: yazan kısmın yanında yer alan 

açılır menüden Shape değerini seçiniz. Birinci karenin açık yeşil renge 

büründüğünü görmeniz gerekir. 

 

Şekil 6.8: Shape tween canlandırmasının oluşturulması 

5- 20. karenin üzerine sağ tıklayınız ve Insert Keyframe değerini veriniz. 

6- 1. kareden 20. kareye kadar yer alan karelerin yeşile boyandığını ve ok şeklinin 

oluştuğunu görmeniz gerekir. 
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7- 20.karede yer alan daireyi siliniz. 1. kareden 20. kareye kadar kesikli çizginin 

oluşması gerekir. Sildiğiniz daire şekli yerine 150 px genişliğinde 50 px 

yüksekliğinde dörtgen çiziniz (Şekil boyutunu Properties panelinde yer alan 

W: ve H: değer alanlarına uygun değerleri girerek ayarlayabilirsiniz.) 

8- Ok şekli yeniden oluşur. 40. kareye de anahtar kare ekleyiniz. 1.karedeki daireyi 

seçiniz ve kopyalayınız. 40. dairedeki dörtgeni siliniz. 

9- Edit → Paste in Place komutuyla 1. karedeki daireyi 40. karede aynı yere 

yapıştırınız. 

 
Şekil 6.9: Shape tween için anahtar karelerin oluşturulması 

10- Boş bir alana çift tıklayınız ya da şekil 6.8’de gösterilen Scene1 yazısına tıklayınız 

ve ana sayfaya (sahne 1) geri dönünüz. 

11- Shapetween isimli daireyi çizdiğiniz katmanın adını grafik adıyla değiştiriniz. 

Shapetween nesnenizi seçiniz ve Properties panelinde şekil 6.10’da gösterilen 

alana shapetween değişken adını yazınız. Buraya yazdığınız isimle nesnenize 

verdiğiniz isim aynı olmak zorunda değildir. 

 

Şekil 6.10: Grafik sembolüne değişken adı girilmesi 
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12- Canlandırmanızı çalıştırıp test ediniz. Önce daireden dörtgene ve ardından 
dörtgenden daireye dönüşen bir canlandırmanın oluşması gerekir. Flash 
oynatıcısını kapatınız ve çalışma alanına geri dönünüz. 

13- Grafik katmanının üzerinde eylem adında yeni bir katman oluşturunuz. 

14- Window → Actions komutuyla eylem penceresini açınız ve shapetween.stop(); 
komutunu yazınız. Eylem katmanınızın 1 nu.lı karesi üzerinde α simgesinin 
çıkması gerekir. 

15- Grafik katmanının altında butonlar adında yeni bir katman oluşturunuz. 

16- Window → Common Libraries → Buttons komutuyla Şekil 6.11’de gösterilen 
düğmeleri bulunuz ve butonlar katmanına yerleştirin. 

 

Şekil 6.11: Butonlar katmanına yerleştirilecek butonlar 

17- Düğmeleri sırasıyla seçiniz ve her bir buton için Window → Actions komutuyla 
çıkan eylem penceresinde aşağıdaki kodları yazınız: 

Durdurma Butonu:  
on (release){ 

  shapetween.stop(); 

} 

Oynatma Butonu:  
on (release){ 

  shapetween.play(); 

} 

 

Bir Önceki Kare:  
on (release){ 

  shapetween.prevFrame(); 

} 

Bir Sonraki Kare: 
on (release){ 

  shapetween.nextFrame(); 

} 

 

18- Canlandırmanızın ana sayfa görüntüsü şekil 6.12’deki gibi olmalıdır. Control → 
Test Movie komutuyla filminizi oynatınız. Düğmelere tıklayarak sonucu 
gözleyiniz. Filminizi kaydediniz. 
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Şekil 6.12: Shape Tween canlandırmasının 

bitmiş tasarım görüntüsü 

Shape Tween Hakkında: Bu 

canlandırma yöntemiyle yalnızca görüntü 

değişikliğine dayalı canlandırmalar değil,
motion tween gibi hareket canlandırmaları da 

hazırlayabilirsiniz. Hatta renk değişimine dayalı 

oldukça hoş canlandırmalar da hazırlamak söz 

konusudur. 

Uygulama-6.5: Daha karmaşık bir şekle Shape Tween uygulanması 

1- Stage’in (Çalışma Alanı) 1. karesine dolgu rengi ve dış hat rengi farklı olan bir 

oval çiziniz. 

2- 1. kareye tıklayarak seçili duruma getiriniz. Properties panelinde Tween: 

alanından Shape değerini seçiniz. 

3- Zaman çizelgesinde 5. kareye sağ tıklayınız ve Insert Keyframe komutunu 

veriniz. Şeklin 5. kareye kadar bir kopyası oluşturulur. 

4- 5. karedeki oval şekle dört köşeli yonca yaprağı şekli veriniz. (Bu işlem için 

Subselection aracını kullanabilirsiniz. Aracı seçiniz, şeklin dış hattına tıklayınız 

ve çıkan kare şeklindeki tutamaçlardan tutup fareyi farklı yönlere hareket 

ettirerek dört köşe yonca yaprağını elde edebilirsiniz.) 

5- 10. kareye sağ tıklayınız ve Insert Keyframe komutunu veriniz. Dört köşe yonca 

yaprağı şekliniz 10. kareye kadar kopyalanır. 

6- 10. karedeki şekle şekil 6.13’te gösterildiği gibi çiçek sapı ekleyiniz. (Bu işlemi 

gerçekleştirmek için 4. adımda olduğu gibi Subselection aracını kullanmanız 

işinizi kolaylaştırır.) 
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Şekil 6.13: Başlangıç ve bitiş kareleri 

7- Filminizi oynatınız. Çiçeğe sapın eklenmesi, doğru görünen yumuşak bir geçiş 
oluşturmasını zorlaştırır. Oynatım çubuğunu 1. ve 5. kareler arasında 

gezdirdiğinizde düzgün bir geçişin olduğunu ancak 5. ve 10. kareler arasında 

bozulmalar olduğunu fark etmelisiniz. 

8- Bunu engellemek amacıyla Shape Hints (Şekil ipuçları) kullanılır. 5. kareyi 

seçiniz ya da oynatım kafasını 5. kareye götürünüz. Modify menüsünden Shape 

→ Add Shape Hint komutuyla ya da Ctrl+Shift+H tuşlarıyla ilk şekil ipucunu 

ekleyiniz. (Şekil ipuçları a harfinden başlamak üzere küçük daireler şeklinde 

eklenen etiketlerdir, şeklin merkezine eklenir.) 

9- Arrow aracını kullanarak fare imleciyle ilk a harfli şekil ipucu etiketini sorunlu 

noktaya taşıyınız (Şekil 6.14). 

10- Bir şekle birden fazla şekil ipucu ekleyebilirsiniz. 8. adımı tekrarlayarak iki tane 

daha şekil ipucu ekleyiniz. b harfli etiketi sapın ucunun çıkacağı noktaya ve c 

harfli etiketi de diğer kenara yerleştiriniz (Şekil ipuçlarının saat yönünün tersinde 

yerleştirilmesi Flash için daha iyidir.). 

 
Şekil 6.14: Şekil ipuçlarının eklenmesi 
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11- 10. kareyi seçiniz ya da oynatım kafasını 10. kareye götürünüz. a, b, c etiketli 

şekil ipuçlarının üst üste bindiğini göreceksiniz. Arrow aracını kullanarak her bir 

etiketi sırasıyla uygun yere taşıyınız. 

12- Şeklinizin durumuna göre daha fazla şekil ipucu eklemeniz gerekiyorsa 

8-11. adımları yineleyiniz. Canlandırmayı oynatınız ve sonucu gözleyiniz. 

6.3. Sesli Canlandırmalar Hazırlamak 

Flash çok farklı formatlarda sesleri çalabilme özelliğine sahiptir. Windows işletim 

sisteminin ses formatı olan .wav, Macintosh işletim sisteminin ses formatı olan .aiff, 

QuickTime filmlerinin sesleri, .au dosyaları ve tüm platformlarda kullanılan .mp3 dosyaları 

flash tarafından kullanılabilir. Bir filme ithal edilen ya da kopyalanan tüm sesler, o filmin 

kütüphanesinde (Library) kalır. 

Uygulama-6.6: Düğmelere seslerin eklenmesi 

1- Window → Common Libraries → Buttons komutuyla düğme kütüphanesini 

açınız. 

2- Listeden Push Buttons klasörünü bulunuz ve üzerine sağa tıklayınız. Expand 

Folder komutunu veriniz ve push button – blue düğmesini çalışma alanına 

sürükleyin ve bırakınız. 

3- Düğmenin üzerine çift tıklayınız ya da düğmeyi seçtikten sonra Edit → Edit 

Selected komutunu çalıştırınız. 

4- Düğmenin içine girdikten sonra en üst katmanı seçiniz. Insert → Layer (Flash 8 

için Insert → Timeline → Layer) komutuyla ya da Insert Layer simgesine 

tıklayarak yeni bir katman ekleyiniz. Katmana ses adını veriniz. 

5- Ses katmanında Over karesini seçiniz ve karenin üzerine sağ tıklayarak Insert 

Blank Keyframe komutunu çalıştırarak boş bir film karesi ekleyin. Down 

karesini seçiniz ve aynı şekilde boş bir film karesi ekleyiniz. 

6- Düğmeler penceresini kapatınız. Over karesini seçiniz ve Window → Common 

Libraries → Sounds (Flash 8’in ses kütüphanesi olmadığı için File → Import 

→ Import to Library komutunu çalıştırınız ve bilgisayarınızdan kısa bir ses 

dosyası ekleyiniz.) komutuyla Flash ses kütüphanesini açın. 

7- Sol yanında hoparlör simgesi ( ) olan ve sağ yanında Sound yazan ses 

dosyalarından istediğiniz birini seçiniz ve çalışma alanına sürükleyiniz. (Flash 8 

için kütüphaneyi [Window → Library] açınız ve eklediğiniz ses dosyasını 

listeden seçip çalışma alanına sürükleyiniz.) 
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Şekil 6.15: Sounds paneli Şekil 6.16: Ses dosyasının anahtar kareye 

eklenmesi ve katman yüksekliğinin 

büyütülmesi 

8- Anahtar kare içinde şekil 6.16’da gösterildiği gibi ses dalgasının belirdiğini 

görmeniz gerekir. Ses katmanını seçiniz ve üzerine sağ tıklayınız. Properties 

komutunu çalıştırınız ve Layer Height değerini %200 yapınız. 

9- Ses katmanında Down karesini seçiniz ve bir ses dosyası ekleyiniz. 

10- Düğmeyi bütün bir nesne olarak görmek için Scene 1 yazısına tıklayın ya da boş 
bir alana çift tıklayınız. 

11- Filmi çalıştırmadan düğmeyi test etmek için Control menüsünden Enable Simple 

Buttons komutunu çalıştırınız ya da Ctrl+Alt+B tuşlarına basınız. 

12- Fare imlecini, düğmenin üzerine getirdiğinizde Over karesindeki ses, düğmeye 

tıkladığınızdaysa Down karesindeki ses çalınır. 

Uygulama-6.7: Seslerin farklı Sync modlarında kullanılması 

 

Şekil 6.17: Farklı Sync modlarının seçilmesi 

Flash’da sesler dört farklı eylem türüyle kullanılabilir. Bunları kısaca şöyle 

açıklayabiliriz: 
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Event - Olay: Varsayılan çalma türüdür. Sesin ne kadar kare kapladığı önemli 
değildir. Henüz sesin bitim noktası gelmemişse, film diğer karelere geçse bile ses çalmaya 
devam eder. Film başa döndüğünde, ses henüz bitmemiş olsa bile sesin bir başka örneği 
başlatılır. 

Start - Başlat: Ses klibi zaten çalınıyorsa sesin ikinci bir örneği başlatılmaz. Eğer ses, 
film oynatıcısı sesin çalındığı kareye yeniden gelmeden bitmişse yeni bir ses başlamaz. Film 
oynatıcısı, ne zaman sesin olduğu kareye gelirse o zaman ses çalınır. 

Stop - Durdur: Bu eylem türünün kullanıldığı kareye gelindiğinde ses kesilir. 

Stream - Akan: Ses akışının belli bir hareketle ilişkilendirilmesi istendiğinde 
kullanılır. Flash o ses klibini daha küçük alt kliplere parçalar ve ayrı karelere gömer. Filmin 
kare gösterim hızı (frame rate), alt kliplerin boyunu belirler. Örneğin 10fps’lik kare 
gösterim hızına sahip bir filmde, Flash akan sesi bir saniyenin onda biri uzunluğunda alt 
kliplere böler. Flash, bu sesin, her 10 karede 1 saniyesini çalar. 

Flash, her alt klibin başlangıcını filmdeki belirli bir kareyle senkronize eder. Ses, 
Flash oynatıcının kareleri görüntülemesinden daha hızlı oynatılırsa, Flash oynatıcı, 
canlandırmanın bazı karelerini görüntüleyemez. Bu sebepten dolayı ses ve görüntü mümkün 
olduğunca eş zamanlı (senkronize) olmalıdır. 

1- Uygulama 3.17’de yaptığınız canlandırmayı açınız. 

2- En alta maskelenmemiş Normal modda bir katman ekleyiniz. 

3- 5., 10. ve 15. karelere boş anahtar kare ekleyiniz. 

4- 1., 5., 10. ve 15. karelere Sounds panelinden bir ses ekleyiniz. 

5- Filminizi oynatınız. Seslerin nasıl çalındığına dikkat ediniz. 

6- Flash oynatıcısını kapatınız. 1., 5., 10. ve 15. kareleri sırasıyla seçerek Properties 

panelinden Sync modu olarak Stream değerini seçiniz. Filminizi tekrar oynatınız 
ve farka dikkat ediniz. 

7- 15. kareyi seçiniz ve farenin sol tuşu basılıyken 10. kare üzerine sürükleyiniz. 10. 
kareye yerleştirdiğiniz anahtar karenin 20. kareye kadar devam ettiğini görmeniz 
gerekir. 

8- 1. ve 5. karelerdeki sesleri yeniden Event moduna alınız. 10. kareyi seçiniz. 
Properties panelinde “Sound:” etiketinin yanında yer alan açılır listeden 
durdurmak istediğiniz sesi seçiniz. 
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4-  Eğer ses klibini kendi isteğinize göre düzenlemek istiyorsanız, ses klibini 

eklediğiniz kareyi seçiniz ve Properties panelinde Edit düğmesine tıklayarak 

Edit Envelope penceresini açınız. 

5- Şekil 6.19’da gösterildiği gibi fare imleciyle içi boş kareye tıklayınız ve 

istediğiniz konuma sürükleyiniz. Daha fazla içi boş kare eklemek için (Değişim 

noktası) ses klibi ön izleme ekranında gözüken çizgiye tıklayınız. Yeni bir 

değişim noktası oluşturulur. 

6- Filminizi çalıştırınız ve yaptığınız değişikliklerin etkisini anlamaya çalışınız. 

6.4. Zaman Doğrusu Efektlerini (Timeline Effects) Kullanmak 

Flash 8’de zaman doğrusuna (Timeline) çeşitli hazır canlandırmalar ekleyerek 

zamandan kazanabilir ve animasyon hazırlama işlemini sıradan kılabilirsiniz. 

Uygulama-6.9: Zaman doğrusunda yer alan iki ayrı grafik öğesine farklı efektlerin 

uygulanması 

1- Flash 8’de boş çalışma sayfası açınız. 

2- Layer 1 isimli katmanın 1. karesine 200 px-200 px genişliğinde dış çerçevesi 

olmayan içi dolgulu bir daire çiziniz. 

3- 1. kareyi seçiniz ve Insert → Timeline Effects → Effects → Blur komutunu 

çalıştırınız. 

 

Şekil 6.20: Blur efektinin uygulanması 

4- Blur efektiyle ilgili ayar penceresi ekrana gelir. 
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Şimdi sırayla bu bileşenleri inceleyelim.

1.2.1. Button(Düğme)

Bu bileşen sayesinde form üzerine düğmeler yerleştirebilir ve SWF dosyanızın
çalışması sırasında basıldığı zaman gerçekleşmesini istediğiniz işlemleri bağlayabilirsiniz.
Bir web sayfasında gördüğünüz onayla, kaydet, sil gibi button tipi girdiler bu bileşenden
oluşturulmuştur. Örneğin bir button bileşenine ilgili actionscript yazıldığında ve çalışma
esnasında bu bileşene tıklama ile istenilen bir web sitesinin açılması sağlanabilir. Bu bileşen
yine görsel olarak rollover ( ) (Üzerine gelme) ve click() (tıklama) efektlerine sahiptir.

Her bileşenin parametreleri vardır. Bu parametreler bileşenlerin kullanılmasını ve bazı
ayarların yapılmasını sağlar. Bu parametrelerden en önemlileri şunlarıdır.

Şekil 1.2.2.: Button (düğme) parametreleri

 Icon: Button bileşeni üzerine icon yerleştirmek için kütüphanede (Library)
kullanılacak iconun ismi yazılır.

 Label: Buton bileşeninin üzerinde yazacak etiket ismi yazılır.
 LabelPlacement: Label ile yazdığımız etiket isminin sağda mı (right), solda mı

(left), iconun üstünde mi (top) ve iconun altında mı (bottom) ayarı yapılır.
 Enable: Bu parametre false seçilirse button bileşeni etkinliğini kaybeder. Eğer

bu parametre true seçilirse tekrar button bileşeni etkinleşir.
 Visible: Bu bileşenin ekranda görünüp görünmemesini sağlar. Eğer bu

parametre false ise ekranda görünmez, true yapıldığında ise tekrar ekranda
görünür.
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1.2.2. Label (Etiket)

Bu bileşen ile form üzerine statik yazılar yazılır. Form üzerinde açıklama bilgilerini bu
bileşen kullanarak yapacaksınız. Bu bileşenin en önemli parametreleri şunlardır:

Şekil 1.2.3.: Label (etiket) parametreleri

 Autosize: Label (Etiket) içerisine yazılan metnin bileşen içerisinde sağa, sola
veya ortalı şekilde mi yazılacağı belirlenir. Bu parametrede None seçildiğinde
normal ayarı, Left seçildiğinde sola dayalı, Right seçildiğinde sağa dayalı ve
center seçildiğinde metnin ortalı yazılmasını sağlar.

 Text: Label (Etiket) içerisine yazılacak metin bu parametre içerisine yazılır.

1.2.3. Checkbox (Onay Kutusu)

Bu bileşen kullanıcıların seçenek grubu içerisinden bir veya birkaçını seçip
kullanmasını sağlamaktadır. Örneğin bir web sitesine üye olurken size hobileriniz veya ilgi
alanlarınız sorulduğunda ilgili seçenekleri seçmeniz için onay kutusu kullanılır. Bu bileşenin
en önemli parametreleri şunlardır:

Şekil 1.2.4.: Label (etiket) parametreleri
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 Label: Checkbox bileşeninin üzerinde yazacak etiket ismi yazılır.
 LabelPlacement: Label ile yazdığımız etiket isminin sağda mı (right), solda mı

(left), onay kutusunun üstünde mi (top) ve onay kutusunun altında mı (bottom)
olacağının ayarı yapılır.

 Selected: Checkbox’ın (onay kutusu) seçili olup olmadığı belirlenir. Eğer bu
parametre true değerini alırsa onay kutusu seçili hale gelir yani onay kutusuna
çeltik konur. False değerini alırsa onay kutusundaki çeltik işareti kalkar.

1.2.4. Combobox (Açılır Menü Kutusu)

Bu bileşen kullanıcıya açılır şekilde bir menü sunar ve bu menüde seçim yapılmasını
sağlar. Örneğin kullanıcının öğrenim durumunu (ilköğretim, ortaöğretim, lise, üniversite)
gibi seçenekleri bu açılır menüye yazarak kullanıcının bunlardan birini seçmesi sağlanabilir.

Şekil 1.2.5.: Combobox bileşeni

Bu bileşenin en önemli parametreleri şunlardır:

Şekil 1.2.5.: Combobox parametreleri

 Data: Bu parametre label (etiket) de yazdığımız ve seçeceğimiz eylemin ne
olacağını bildirir. Örneğin combobox’ımızın label’a( etiket) yazdığımız
“google’a git” yazısı seçildiğinde yapacağı eylemi, data parametresinin ilgili
değerine “http://www.google.com.tr” yazarak sayfanın açılmasını sağlarız.
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 Editable: Bu parametre combobox bileşeninin içerisine bilgi girişi yapabilmek
için düzenleme işlemi yapar.

 Label: Combobox (açılır menü kutusu) bileşenine bilgi girişi yapılarak.
Çalışma anında ekranda yönlendirecek bilgileri göstermek için kullanılır. Açılır
menüde görmek istediğiniz bilgiler ekranda görmek istediğiniz sıraya göre
yazılmalıdır.

 Rowcount: Combobox (açılır menü kutusu) bileşenin içindeki bilgilerin aynı
anda kaç tane gösterileceği belirlenir. Yani combobox bileşeni açıldığında
ekranda 2 adet bilgi göstermek istiyorsanız bu özelliği 2 olarak değiştirin. Eğer
bu durumda 2’den fazla bilgi varsa aşağı yukarı kaydırma çubuğu ile hareket
sağlayabilirsiniz.

1.2.5. List (Liste)

Bu bileşen combobox bileşenine benzer. Farkı birden fazla veri satırını belirli bir satır
sayısından sonra kaydırılabilir hâle gelen bir açılır listede görüntülemek yerine, hepsini aynı
anda görüntülemesidir. Diğer bir farkı istenirse birden fazla ögenin aynı anda seçilmesini
sağlar. Bu bileşenin en önemli parametreleri şunlardır:

Şekil 1.2.6.: List parametreleri

 Data: Combobox bileşende bulunan parametrenin görevi ile aynı işlevi yapar.
 Label: Combobox bileşende bulunan parametrenin görevi ile aynı işlevi yapar.
 MultipleSelection: Bu parametre list bileşenini anlatırken söylendiği gibi

birden fazla seçime olanak sağlar. Bu özelliği aktif etmek için True değerini
seçmek gerekir.

 RowHeight: Bu parametre ise list bileşeni içerisinde yazılacak metinlerin satır
yüksekliğini ayarlamamızı sağlar.

1.2.6. Textinput (Metin Girdisi)

Bu bileşen kullanıcının dışardan tek satırlık metin girişi yapmasını sağlar. Örneğin
kullanıcıya adını ve soyadını girdirmek için, bir email adresi girdirmek için veya bir şifre
girdirmek için bu bileşen kullanılır. Bu bileşene girilen metin actionscript kodlarıyla
toplanarak bir belgede kullanılır üzere sunucuya gönderilebilir. Bu bileşenin en önemli
parametreleri şunlardır:
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Şekil 1.2.7: Textinput parametreleri

 Editable: Bu parametre true Textinput (Metin girdisi) bileşenine dışardan metin
girişi yapılmasını saplar. Eğer false değeri seçilirse dışardan metin girişi iptal
edilmiş olur.

 Password: Kullanıcının dışardan girdiği verilerin nokta nokta şifreli
görüntülenmesi için kullanılan parametredir. Özellikle şifre girişlerinde
kullanılır. Eğer true değeri seçilirse girilen metin şifrelenir.

 Text: Metin verilerinin girildiği parametredir. Actionscript ile bu değer
değiştirilebilir veya kullanıcı girdiği metin verilerini bu parametrede saklar. Bu
parametreyi çalışma esnasında değiştirebilirsiniz.

 MaxChars: Bu parametrede girilen metnin maximum kaç karakterden olacağı
sınırlandırılabilir. Yani bu parametreye 15 değeri girdiğimizde kullanıcı
dışardan maximum 15 karakterlik veri girebilir.

1.2.7. TextArea (Metin Alanı)

Bu bileşen de textinput (Metin girdisi) gibi bir bileşendir. Metin girdisinden farkı, çok
satırlı olmasıdır. Kaydırma çubukları ile görüntülenecek alana sığmayan metinlerin
görüntülenmesi sağlanır. Böylece kullanıcıdan bilgi toplamak amacı ve bilgi görüntülemek
amacıyla kullanılabilir. Özellikler uzun metinler için çok kullanılır. Bu bileşenin en önemli
parametreleri şunlardır:



12

 Maximum: Bu parametre ile maximum girilecek veya seçilecek sayı girilir.
Örneğin 10 değeri girilmişse kullanıcı dışarıda maximum 10 değerini girebilir
veya seçebilir.

 Minimum: Bu parametre ile minimum girilecek veya seçilecek sayı girilir.
Örneğin 0 değeri girilmişse kullanıcı dışarıda minimum 0 değerini girebilir veya
seçebilir.

 StepSize: Bu parametre ise minimum ve maximum değerler arasıda artış
miktarını belirler. Örneğin bu parametre 2 seçilirse sayılar 2’nin katları şeklinde
artar.

 Value: Kullanıcının seçtiği veya girdiği sayısal değerlerin tutulduğu
parametredir. Actionscript’de bu parametre ile kullancının girmiş olduğu değeri
okuyabiliriz.

1.2.9. Radio Buton (Radyo Düğmesi)

Bu bileşen kullanıcıların birden fazla seçenekten sadece bir tanesini seçmeleri
gerektiğinde kullanılır. Örneğin formunuzda kullanıcının cinsiyetini sorduğunuzda, kullanıcı
ya erkek ya da bayan seneklerinden birini seçmek zorundadır. Bu tür durumlarda
radiobutton(radio düğmeleri) bileşeni kullanılır. Bu bileşenin en önemli parametreleri
şunlardır:

Şekil 1.2.8: RadioButton parametreleri

 GroupName: Bu parametre ile birden fazla radiobutton kullandığınızda
bunların yanı grup içerisinde bir tanesini seçebilmek için bu parametreye aynı
isimleri vermek gerekir. Farklı bir isim verdiğinizde diğer radiobutton
grubundan çıkar. Örneğin Cinsiyet seçiminde “Erkek” ve “Bayan”
seçeneklerinden birini seçebilmek için bu radiobuttonların aynı group içinde
olması gerekir.

 Label: Bu parametre ile radiobutton’un etiket ismi yazılır. Yani radiobutton’un
Erkek veya Bayan olduğunu buraya yazarak kullanıcıyı bilgilendiririz.

 LabelPlacement: Label ile yazdığımız etiket isminin sağda mı (right), solda mı
(left), Radyobuttonun üstünde mi (Top) ve Radyobuttonun altında mı (Bottom)
olacağının ayarı yapılır.

 Selected: Bu parametre true olursa radiobutton işaretlenmiş olur.
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ÖĞRENME FAALİYETİ - 2

Dinamik olarak veri girişini yapacaksınız. Web servis bileşeni oluşturarak gerekli
bağlantıyı sağlayıp, web sitesindeki bilgileri alacak ve animasyonda kullanabileceksiniz.
Geri bildirim formunu kullanarak size mail atılmasını sağlayabilecek. anket
oluşturabileceksiniz

 Dinamik verilerin, statik verilere göre avantajlarını araştırınız.
 Web servisinin hangi programlama dilleri ile yapıldığını araştırınız.
 Animasyon programınızda kullanacağınız web servis bileşeni özelliklerini

araştırınız.
 Web üzerindeki anketlerle ilgili araştırma yapınız.

2. DİNAMİK VERİLER

2.1. Dinamik Verilere Giriş

Animasyon programınız size metinleri dinamik olarak görüntüleyebileceğiniz alanları
tanımlamanıza olanak sağlar. Dosyanızı dinamik verileri alacak şekilde ayarlayarak
verilerinizin dosyanız çalışırken işlenmesi, değiştirilmesi veya depolanmasını
sağlayabilirsiniz.

Dinamik veriler 3 şekilde karşınıza çıkar. Bunlar:

 Kullanıcı destekli bilgiler
 Dinamik metin alanları oluşturarak bilgi alma
 Kontrol edemeyeceğiniz veriler olabilir.

Kullanıcı destekli bilgiler programınız çalışırken kullanıcı tarafından girilen verilerdir.
Dinamik metin alanlarından yüklenen verilerde ise verilerinizin dış ortamda bir metin
dosyasından verileri alarak animasyonunuza yüklenmesi işlemidir. Son olarak kullanıcı
tarafından değiştirilemeyen verileri ise örneğin sistem saati, günü vb. işlemler dinamik
verilerdir.

Animasyonunuzda en çok dinamik metin alanları oluşturarak bilgi alma işlemini
kullanırsınız. Bunun sebebi ise animasyonunuza yazdığınız her metnin statik (durağan)

ÖĞRENME FAALİYETİ–2
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olmasıdır. Bu metinde bir değişiklik yapacağınızda, her seferinde animasyonunuzu açarak
değişiklik yapmanız gerekir. Bunu önlemek ve text tool (Metin aracını) dinamik olarak
tanımlamanız ve dış ortamda hazırlayacağınız metin dosyasından almanız, yapacağınız
işlemleri daha da kolaylaştıracaktır.

Animasyon programınızda 3 tür metin vardır. Bunlar:

 Durağan metin (Statik Text)
 Giriş metni (Input Text)
 Dinamik metin (Dynamic Text)

Durağan metin Text Tool (metin aracı) ile oluşturulmuş ve animasyon dosyanızla bir
kere oluşturulur. Yazının boyutu rengi gibi ayarlamaları yapamaz ve içeriği
değiştiremezsiniz.

Giriş metni ile çalışma anında düzenlenebilecek bir metin alanıdır. Text Tool (metin
aracı) ile kullanıcıların metin girebildikleri yerdir. Bu metin türü genelde kullanıcı tarafından
girilen verilerin işlenmesi için sunucuya gönderilecek metinsel bilgiyi almak için kullanılır.

Resim 2.1.1: Metin türleri

Dinamik metin alanı ise Text Tool (metin aracı) ile oluşturulmuş ve animasyon
dosyanız çalışırken metnin istediğiniz doğrultuda değiştirilmesini sağlar. Bu seçimlerin
değiştirilmesi sonucunda özellikler penceresinde de değişiklikler meydana gelir.

Dinamik Metin (Dynamic Text) seçtiğinizde çıkan önemli özellikleri şunlardır:

 Line Type (satır tipi): Single line seçilirse tek satırlık bir yazı yazdırılır.
Multiline seçeneği ile birden çok satırla yazdırma olanağı sağlanır.

 Selectable (seçilebilirlik): Bu seçeneğe tıklarsanız, fare imleci I çizgisine
dönüşecektir. Böylece metini seçme veya kopyalama işlemi yaptırılabilir.

 Show Border (kenarlık görüntüle): Bu seçenek işaretlenirse text tool ile
yazdığınız alanın kenarlıkları görüntülenecektir. Bu özellik kullanıcıya dışardan
veri girişi (Input Text) yaptırılacaksa kullanılmalıdır.
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Flashta oluşturulan uygulamayı çalıştırma : Ctrl + Enter tuşlarına birlikte basılır. 
 
Oluşturulan projeyi dışarı aktarma (swf olarak):  
Dosya --- Dışa aktar---Filmi dışa aktar ---kayıt türü swf olarak seçilir. 
 
Nesne Çizimi: Nesne çizimi için araçlar panelinden nesne çizimi (J) aktif olmalı. Bu durumda 
birbiri üzerine çizilen şekiller birbirine karışmaz. 

 
Örneğin, yukarı daire ve dikdörtgen şekilleri birbiri üzerine çizildiğinde şekillerin biçimi 
bozulmaz. 
 
Hatırlatma : Araç çubuğundaki araçlardan örneğin oval aracı altındaki diğer araçları da 
görmek için Mouse ile sol tuşa tıklanarak basılı tutulur! 
 
Dolgu rengi ve kontur rengi olan bir şekli taşıma : Şeklin tamamı seçilir veya dolgu rengi 
içersine çift tıklanır. 
 
Semboller: Flashta bir kez oluşturulduktan sonra sahne alanında tekrar tekrar kullanılmayı 
sağlayan bir terimdir.  

Bir animasyonun aynısının birden fazla olması istenirse gerekli animasyon 
sembollerde oluşturulur ve daha sonra sahneye aktarılır. Sembollerinde kendine ait tıpkı sahne 
alanında yer alan zaman çizelgesi vardır. 
Semboller kitaplık panelinde yer alır.  

Sembol oluşturmak için ekle menüsünden---yeni sembol seçilir (ctrl + f8) 
3 çeşit sembol vardır. 
1) Film Klibi : Hareketli animasyonların gerçekleştirildiği semboldür. 
2) Düğme sembolleri: Etkileşimli butonlar oluşturmada kullanılır. Film ve grafik 

sembollerinden zaman çizelgesi yönünden farklıdır. Çünkü sadece 4 kare bulunur. 
3) Grafik sembolleri: Hareketsiz yani animasyon uygulamayı düşünmediğimiz 

resimler için kullanılır. Bu semboller actionscripti desteklemezler ve bu sembollere ses te 
ekelenemez. 

 
Nesneleri sembollere dönüştürme:  
Sahne alanına çizilmiş bir nesneyi sembole dönüştürmek için önce nesne seçilir ve 

ardından f8’e basılır. Ardından sembol çeşidi seçilir. 
 

Flashta frameler (kareler) 
 

Bir animasyon oluşturmada karelerden yararlanılır. Her bir hareket karelerde gerçekleşir. 
Sahne içerisine çizilen farklı şekiller kareler içerisinde tutularak, verilen  özel efektler 
yardımı ile film oluşturulur.  Flash animasyonları için karelere düşen görev oldukça 
büyüktür. Sahne alanının kullanımından sonra en çok kullanılan yer karelerdir.   
Flashta kullanılan 3 çeşit kare mevcuttur: 

1) Anahtar kare : sahne içerisine bir nesnenin girilmesi için  gerekli olan karedir. İlk 
kare her zaman anahtar karedir. Bir animasyonda mutlaka en az 2 anahtar kare 
bulunması gerekir. 1.si animayonun başlangıcını 2.si ise bitişini gösterir. Bir karenin 
sahne içersinde hareketi gerçekleştirilirken karenin hareket yönünde değişiklik 

LAB2
Vurgu



 

2 FLASH CS3 DERS NOTLARI - 2013 

yapılması istendiği karede anahtar kare eklenir. Anahtar kare eklemek için kare 
üzerine sağ tıklanır ve ana kare ekle seçilir yada F6 tuşuna basılır. 

2) Boş anahtar kare: Bir nesnenin başka bir nesneye, yazıya dönüşmesi istendiği 
durumlarda kullanılan karedir. Bu kare eklendiğinde sahnedeki 1.karede var olan 
nesne eklenen karede kaybolur. F7 tuşu ile eklenir. 

3) Kare : Bu kare çeşidi 2 kare arasındaki süreyi uzatmada kullanılır. Animasyonun 
gerçekleşme süresini arttırır. F5 tuşu ile eklenir. 

 
Not: Flash açıldığında ilk kare otomatik olarak anahtar karedir. Boş kareye hiçbir zaman 
nesne çizimi gerçekleştirilemez. 
 
Flashta Hareketli Canlandırmalar Oluşturma: 
 
Flashta nesneyi hareketlendirmek için 1.kareye nesnenin ilk konumu istenilen kareye ise 
nesnenin son konumu çizilir ve 2 kare arası doldurulur. Bunun yanında kare kare 
animasyonda yapılabilir.Ancak bu uzun ve zahmetli bir yöntemdir. Ara oluşturmada 2 
yöntem kullanılır: 

 
1) Hareket arası oluştur (Create motion tween) : Bir nesnenin bir yerden başka bir 

yere hareketini gerçekleştirmede kullanılır. 
 
2) Şekil arası oluştur (Create shape tween): Bir nesnenin başka bir nesneye 

dönüştürülmesini sağlamada kullanılır. Örneğin 1.karede çizilen bir dikdörtgen 
şeklinin 20.karede bir daireye dönüştürülmesi istendiğinde 1.ve 20.kare arası şekil 
arası oluştur seçilir. 

 
UYGULAMALAR: 
 
1) Sahne üzerine çizilen bir dairenin sağa doğru hareketi. 

- Önce sahnenin soluna 1.karede iken (frame) daire çizilir. 
- 30.kareye Mouse ile tıklanarak seçilir ve F6’ya basılarak anahtar kare eklenir. 
- 30.kare seçili iken sol tarafta bulunan daire shift + sağ oka basılarak sağa tarafa 

doğru taşınır. 
- 1. Ve 30. Kare arasındaki herhangi bir kareye sağ tıklanır ve hareket arası 

oluştur seçilir. 

      
2) 1.kareye çizilen bir dairenin 30.karede kareye dönüşmesinin sağlanması: 
 

- 1.kareye daire çizilir. 
- 30.kareye mouse’un sol tuşu ile tıklanır ve klavyeden F7’ye basılarak boş ana 

kare eklenir. 
- 30.kare seçili iken sağ tarafa shift tuşuna basılı tutularak orantılı bir kare 

çizilir. 
- 1. Ve 30. Kare arasındaki herhangi bir kareye sağ tıklanır ve şekil arası oluştur 

seçilir. 
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3) Bir topun zikzaklı yolu takip etmesi: 
- Seçili katmanda zikzaklı yol çizilir. 
- Yeni bir katman oluşturulur. 
- Yeni katmanda daire çizilir. 
- Çizilen daire 1.karede yolun başlangıcına kaydırılır. 
- 20.kare seçilir ve F6’ya basılarak anahtar kare eklenir. 
- 20.kare seçili iken daire üst tepe noktasına (1) kaydırılır. 
- 1 ile 20 arasındaki herhangi bir kareye sağ tıklanarak “hareket arası oluştur” 

seçilir.  
- 40.kare seçilerek F6’a basılır. 40.kare seçili iken daire 2 konumuna getirilir.  
- 20 ile 40 arasındaki herhangi bir kareye sağ tıklanarak hareket arası oluştur 

seçilir, ve işlemler bu şekilde devam eder. En son animasyonu çalıştırmak için 
Ctrl + Enter tuşlarına birlikte basılır. 
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SİZ YAPIN ? Bir karenin sol üst köşesine çizilen bir yıldızın kenarları boyunca sağa 
doğru dönerek hareket etmesi ve başlangıç noktasına dönmesi. 
 
Hatırlatma: Yıldız eklemek için araç panelinden çokgen/yıldıza tıklanır. Özellikler 
panelinden seçeneklere tıklanır. 

  
 
Hatırlatma:Nesneyi sağa doğru döndürmek için1-20 arasına tıklanır aşağıdaki 
özellikler panelinden döndür seçilir.  
Not : 20.kare eklenir iken hem yıldız hem de kare katmanının 20.karesi seçilmelidir. 
 

 
 

KLAVUZ KATMAN: 
Sahne üzerindeki şeklin veya nesnenin çizilen yol boyunca hareket etmesini sağlayan 
katmandır. Klavuz katman eklemek için katman ekle nesnesinin yanındaki hareket 
klavuzu ekle simgesine tıklanır. Not: Bir klavuz katmana 2 farklı yol çizilebilir! 
Klavuz katman şeklin bulunduğu katmanın üstünde oluşur. 
 

 
Klavuz katmanı seçili iken mavi renkli dalgalı yol çizilir (fırça aracı ile) 
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Karenin klavuz katman boyunca hareketi : Yukarıdaki yapı oluşturulduktan sonra; 
- 30. Kare her iki katmanda seçilir ve F6’a tıklanır. 
- Kare katmanının 1.karesinde iken kare yolun başladığı noktaya taşınır. (Karenin 
merkezi uç noktaya değecek) 
- Kare katmanının 30.karesinde iken kare yolun bittiği noktaya taşınır. (Karenin 
merkezi uç noktaya değecek) 
- Kare katmanının 1. Ve 30. kare arasındaki herhangi bir kareye sağ tıklanır ve hareket 
arası oluştur denilir. 
 
Not : Uygulama çalıştığında klavuz katmanda çizilen yol görünmez. Yolun görünmesi 
için kare katmanın altında yeni katman oluşturulur ve klavuz katmanda çizilen yol 
kopyalanarak yeni oluşturulan katmana(yol katmanı) yapıştırılır. 

    
 

 
SİZ YAPIN ? 

 
 
SİZ YAPIN ?  

 

Yandaki animasyonda daire yolu 
dolanarak karenin bulunduğu 
noktaya, kare de dairenin bulunduğu 
noktaya doğru hareket edecektir. 
Animasyon çalışırken klavuz 
katmanda çizilen yol görünecektir. 
Bunun için klavuz katmanın kopyası 
en alt katmana yapıştırılmıştır. 

Yandaki animasyonda yıldız klavuz 
katman1’de çizilen yol boyunca; daire 
ise klavuz katman2’de çizilen daire 
boyunca hareket edecektir. Bu hareket 
esnasında klavuz katmanlarda çizilen 
yollar animasyon hareket ederken 
görünecektir.  
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Flashta Tekerlek Çizimi :  
- Dolgu rengi olmayan kontur rengi olan daire çizilir. 
-  Nesne çizimi aktif iken (J) çizgi aracına tıklanır ve dairenin ortasına çizgi çizilir. 

(Çizginin düz olması için shift tuşuna basılı tutulur.) 

 
 

- Daire ve çizgi birlikte seçili iken hizalamadan sahne alanına ifadesi aktif iken yatayda ve 
dikeyde ortala seçilir. 

 
 

- Çizgi seçilerek çoğaltılır. Değiştir-Dönüştür-Ölçekle ve dönüştür seçilerek Döndür 
değerine 45 girilir. Ve uygulama bu şekilde devam eder. Tekerlek çizimi bittikten sonra 
Ctrl + G ile tekerlek gruplanır. 

  
 
Flashta Şeklin Alfa Renginin Giderek Azalması (Örneğin Damlanın Giderek 
Kaybolması) :  

      
 

- 30.karede renk panelinden alfa değeri 0 yapılır, ve 1-30 arası şekil arası oluştur seçilir. 
SİZ YAPIN ?  

                               

Yandaki animasyonda damlanın aşağı 
doğru düşmesini, giderek büyümesini 
ve büyürken kaybolmasını sağlayınız. 
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          Flash’ta Maskeleme :  
Sahne alanındaki bir nesnenin istenilen bölümlerini gösterme yöntemidir.  En az 2 katmana 
ihtiyaç duyulur. 1.katmanda (Üst katman)  maskeleyici nesne (yazı,şekil, yıldız kare…) , alt 
katmanda ise maskelenecek nesne bulunur. Üst katmana sağ tıklanır ve maske seçilir. 

     
 

Maskeleme Kullanarak Animasyon Hazırlama:  
Sahne üzerindeki bir fotoğrafın sol üst köşesinden sağ alt köşesine hareket eden bir daire 
boyunca maskelenmesi uygulamasında; 

- Dosya-İçe aktardan sahne alanına foto eklenir. 
- Foto katmanının üstüne yeni bir katman eklenir ve bu katmana bir daire çizilir. 
- 30.kareye gelinir ve daire sağ alt köşeye taşınır ve hareket arası oluştura tıklanır. 
- Daire katmanı üzerine sağ tıklanır ve maske seçilir. 

        
Bir fotonun 2 farklı şekil ile maskelenmesi : 
- Sahne alanına foto eklenir. Yeni bir katman oluşturulur ( foto katmanının üstünde) ve 
daire katmanı adı verilerek daire çizilir. 
- Daire katmanının üstünde yeni bir katman oluşturulur. Ve bu katmana en alt katmandaki 
foto kopyalanarak yapıştırılır. ( foto 2 katmanda da olacak) 
- Yeni bir katman oluşturularak kare adı verilir ve kare çizilir. 
- Tüm katmanların 30.karesi seçilerek F6’ya basılır anahtar kare oluşturulur. 
- Daire katmanının 1.karesinde daire solda, 30.karede ise sağda olacak şekilde; kare 
katmanının 1.karesinde kare sağda,30.karede ise solda olacak şekilde ayarlamalar yapılır. 
- Kare ve daire katmanları hareket arası oluştur işlemine tabi tutulur. 
- Kare ve daire katmanlarına sağ tıklanarak maske seçilir. 
 
Maskeleyici şeklin altındaki fotonun hareket etmesi : 
- Sahne alanına foto eklenir. 
- Yeni bir katman eklenir. Bu katmanda nesne çizimi aktif değilken 3 şekil çizilir. 
- Her iki katmanın 30.karesi seçili iken anahtar kare eklenir. 1.karede foto solda 30.karede 
ise sağda olacak şekilde ayarlanır ve foto katmanının 1-30 arası hareket arası oluştur 
işlemine tabi tutulur. 
- Şekiller katmanına sağ tıklanır ve maske seçilir. 
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Maskeleme ile Büyüyen dikdörtgen : 

 
- Dikdörtgen katmanında (alt katman) kırmızı dikdörtgen çizilir. 
- Yeni katman eklenir (üste) bu katmanda kırmızı dikdörtgeni kapatacak şekilde 1.karede 
küçük gri renkte şekil çizilir. 
- Her 2 katmanın 30.karesi seçili iken anahtar kare eklenir. 
- Üst katmanın 30.karesi seçili iken klavyeden Q tuşuna basılarak şekil sağa doğru kırmızı 
dikdörtgeni kapatacak şekilde büyütülür ve 1-30 arasına şekil arası oluştur verilir. 
 
Not: Yukarıdaki animasyonda gri dikdörtgen maskeleyici unsurdur. Bu şekil giderek sağa 
doğru büyüdüğünden altındaki kırmızı renkli dikdörtgeni gösterir. 
 
 
SİZ YAPIN ? (Çizgi çizen kalem animasyonu) 

    
 
 

SİZ YAPIN ? (Köpek balığının su içinde hareketi) 

 
Not : İllustrator programından pencere--semboller--Doğadan köpekbalığı flash sahnesine 
sürüklenir. 
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Maske ve Klavuz Katmanın Birlikte Kullanılması: 
- Zemin katmanında degrade ile kırmızı-beyaz karışık geçişli şekil çizilir. 
- Yeni katman oluşturulur ve dikdörtgen şeklinde şekil çizilerek çoğaltılır ve 

gruplanarak (Ctrl + G) ızgara şekline getirilir. 
- Yeni katman oluşturulur ve kırmızı daire çizilir, üzerine beyaz daire çizilerek 2si 

birleştirilir ve hilal haline getirilir. 
- Yeni katman oluşturulur ve yıldız çizilir. 
- Klavuz katman oluşturulur ve yıldız için yol olarak çember çizilir. Çemberin bir 

noktası silgi ile silinerek kesilir. 
- Bütün katmanların 30.karesi seçili iken F6’ya tıklanarak anahtar kare eklenir. 
- Yıldız 1.karede çemberin bir ucuna; 30.karede ise diğer ucuna tutturulur. 
- Yıldız katmanına hareket arası oluştur işlemi uygulanır. 
- Izgara katmanında 1.karede ızgara solda; 30.karede ise sağda yer alır ve hareket arası 

oluştur işlemine tabi tutulur. 
 

 
 
Film Klibini Kullanarak Animasyon Oluşturma : 
Film klibinde oluşturulan animasyon kütüphaneden sahne alanına birden çok defa eklenebilir. 
Örneğin bir kelebeğe kanat çırpma hareketi verip sağa doğru gitmesi istendiğinde kanat 
hareketi film klibinde verilir.  

- Ctrl + F8’e basılarak film klibi oluşturulur ve kelebek ismi verilir. 
- Adobe Illustrator’dan kelebek film klibine sürüklenir. 
- Film klibinde F6’a basılır. Kelebeğin kanatları serbest dönüştürme (Q) ile 

daraltılır. 
- F8’e basılır. Kelebeğin kanatları genişlettirilir. Bu işlem bu şekilde 4-5 defa 

devam ettirilir. 
- Sahne alanına tıklanır, ve kitaplıktan kelebek sahne alanına taşınır. 
- 30.karede anahtar kare oluşturulur. (F6) 
- 1-30 arası hareket arası oluştur işlemine tabi tutulur. Böylece kelebek sağa 

doğru giderken aynı zamanda kanat hereketi yapacaktır. 
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SİZ YAPIN ? (Film klibinde 5 karede kelebeğin kanatlarına kanat hareketi vererek 
sahne ortamında çizilen klavuz katman boyunca kanat çırparak hareket ettirme. ) 

 
 
Film klibinde tekerleği 360 derece sağa doğru döndürme : 

- Ctrl + F8 ile film klibi eklenir, tekerlek film klibinde çizilir. 
- Ctrl + G ile tekerlek gruplanır.  
- 50.kareye anahtar kare eklenir. 
- 1-50 arası hareket arası oluştura tabi tutulur. 
- 1-50 arasında iken özellikler panelinden döndür SY seçilir. 
- Tekerlek sahneye alınır. 
- 30.karede anahtar kare eklenir. 1-30 arası hareket oluştura tabi tutulur. 
- Böylece tekerlek dönerken aynı zamanda saha doğru hareket edecektir. 

 
 
 
Flashta Metin işlemleri : 
Flashta 3 çeşit metin kullanılır. 

1) Statik Metin : Hareketsiz durağan uygulamalarda kullanılır. Örneğin düz metin 
işlemlerinde veya yazının herhangi bir nesneye dönüşmesi uygulamalarında kullanılır. 

2) Dinamik Metin : Kendilerine değer gönderilebilen metin kutularıdır. Çalışma alanının 
herhangi bir noktasına dinamik metin türünde metin kutusu eklediğinizde ve içine 
hiçbir şey yazmadığınızda metin kutusu kesik çizgilerle gösterilir. İçine başka bir 
yerden değer gönderebilirsiniz ya da kendisine daha önceden gönderilmiş değeri 
okuyabilirsiniz. 

3) Giriş Metni : Kullanıcı adı ve şifre girişi işlemlerinde (form uyg.) kullanılır. 
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Önemli Not : Flashta metinler üzerinde grafik işlemleri gerçekleştirirken yazılan 
metinler bir bütün ve grafik nesnesi olmadığından hareketli animasyonlarda metinler 
önce grafik nesnesine dönüştürülerek ( 2 defa Ctrl + B) her bir harf birbirinden 
bağımsız hale getirilir. 

 
Metni Daireye Dönüştürme : 
Metni herhangi bir şekle dönüştürme işlemlerinde önce yazı 2 defa Ctrl + B ile parçala 
işlemine tabi tutulur. Bunun nedeni yazının rasterleştirilmesi içindir. 30.karede F7 ile 
boş anahtar kare oluşturulur ve daire çizilir. 1-30 arası şekil oluştur işlemine tabi 
tutulur. 

  
 
 
UYGULAMA : “TML” kelimesinin harflerinin baştan son harfe doğru sırayla 
tuvalin üstünden altına doğru tek tek düşmesini, yan yana gelmesini ve kelime 
tamamlanınca kelimenin tamamının tekrar başladığı noktaya gitmesini sağlayan 
animasyon. 

- T M L yazılır ve 1 defa Ctrl +B yapılarak metin parçalanır. 
- Parçalanan metnin üzerine sağ tıklanır ve katmanlara dağıt seçilir. 
- Sonra her harfe tek tek aşağıya inme işlemi uygulanır. 

 
SİZ YAPIN ? (T M L kelimesinin harflerinin sağa doğru ortaya çıkan kare içerisinde 
çıkması) 

     
Açıklama : Önce 1.karede içi boş dikdörtgen vardır. Bu dikdörtgen 10.karede çoğalıyor ve 
1.karedeki dikdörtgen içine T harfi geliyor. 
 
 

SİZ YAPIN ? (K E T M L kelimesinin harflerinin sağa doğru hareket eden karenin 
altından ortaya çıkması) 
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Dinamik metin kutusu Uygulaması:(Radio buton ile) 
- 2 katman oluşturulur. (seçenekler katmanı ve mesajın gösterileceği katman) 
- Seçenekler katmanında iken pencere ---- bilişenler ----user interface altından 3 adet 

radio buton eklenir. Her bir radio buton tek tek seçilir ve pencere ----bilişen  denetçisi 
seçilir. 

 
Data ---- Radio butona tıklandığında görülecek yazı 
Group name---- Radio butonların hepsine verilen ortak isim 
Label ---- çalıştırıldığında radio butonun görülecek ismi 
Selected --- Radio butonun başlangıçta seçili olup olmadığı özelliği, true ise seçili, 
false ise seçili değildir. 

 
- Her bir radio buton seçili iken F9’a basılır ve aşağıdaki kodlar film klibi kontrolü 

altından on seçilir ve aşağıdaki kodlar her bir radio buton için yazılır. 
  

- on (press) { 
 _root.mesaj= this.getData() + "alanını seçtiniz"; 
} 

 
5)   mesaj katmanı seçili iken dinamik metin eklenir ve değ kısmına mesaj yazılır. 

 
 

SİZ YAPIN ? (Bileşenlere tıklandığında Doğru Cevap, diğer seçeneklere 
tıklandığında Yanlış Cevap mesajını dinamik metin içersinde gösterme  ) 
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Flashta Giriş Metni ile Kullanıcı Adı ve Şifre Uygulaması:  
Uygulamada kullanıcı adı ve şifre alanlarına girilen bilgiler doğru olduğunda 2.karedeki 

dinamik metin kutusu içersinde TEBRİKLER; yanlış girildiğinde 3.karedeki dinamik metin 

kutusu içersinde YANLIŞ BİLGİ GİRİŞİ mesajı verilecek. 

- Sahneye kullanıcı adı ve şifre metinleri yazılır. 

- Araç kutusundan yazı aracına tıklanır ve özelliklerden giriş metni seçilerek 2 adet 

eklenir. 

- Giriş metinlerine özellikler panelindeki değ kısmından kad ve sifre isimleri verilir. 

- Dikdörtgen çizilir ve gönder ismi yazılarak birlikte gruplanır. Şekil seçili iken F8’e 

basılır düğme seçilir. 

- F6’ya basılarak 2.kareye geçilir. Dinamik metin kutusu eklenir ve özellikler 

panelindeki değ kısmına mesaj ismi verilir. 

- Tekrar F6’ya basılarak 3.kareye geçilir. Aynı dinamik metin kutusu burada da yer 

alır. 

- 1.kare seçili iken F9’a basılır ve stop(); yazılır (Butona basmadan diğer karelere 

geçmesin diye…) 

- 1.karedeki Gönder butonu seçili iken F9’a basılarak kod paneline geçilir ve aşağıdaki 

kodlar yazılır. 

1.YÖNTEM : 
if (_root.kad== “ticaret”  &&  _root.sifre==1978) 

{ 
_root.gotoAndStop(2); 
_root.mesaj= “TEBRİKLER”; 
} 
else 
{ 
_root.gotoAndStop(3); 
_root.mesaj= “YANLIŞ BİLGİ GİRİŞİ”; 
} 
 
2.YÖNTEM : 

Giriş metinlerine özellikler kısmından örnek ad alanlarına kad ve sifre isimleri verilir. 

on(press) { 
if(ad.text=="ketml" && sifre.text==1978) 
        { 
     _root.gotoAndStop(2); 
     _root.mesaj="FOTOĞRAF ALBÜMÜNE HOŞGELDİNİZ"; 
         } 
 else  
       {    _root.gotoAndStop(3); 
           _root.mesaj= "LÜTFEN BİLGİLERİNİZİ KONTROL EDİNİZ!"; 
        } 
       } 

 

Açıklama: Başlıktaki yazı sağa-sola doğru hareket edecektir. (Film klibinde yapılacak). 
Uygulama tek bir karede yapılacaktır. Seçeneklere tıklanıldığında dinamik metin içersinde 
mesaj görüntülenecektir. 
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Dinamik Metin Kutularına girilen Ad Soyadın başka bir framedeki dinamik metin 
kutusunda görüntülenmesi: 

- 1.karede 2 tane dinamik metin kutusu eklenir ve değ kısmından sırasıyla ad ve 

soyad isimleri verilir. 

- F6’ya basılır 2.framede iken dinamik metin kutusu eklenir ve değ kısmından mesaj 

ismi verilir. 

- 1.karede F9’a basılır ve stop(); yazılır. 

- 1.karedeki GÖNDER butonu seçili iken F9’a basılır ve aşağıdaki kodlar yazılır: 

 

On (press) { 
_root.gotoAndStop(2); 
_root.mesaj = “Hoş geldin” + “ ” + _root.ad + “ ” +_root.soyad(); 
} 
 

Açılan kutu ile Yıldız ve Kare Kontrolü : 
Bu uygulamada 1.framede açılan kutu, 2.framede yıldız animasyonu ve 3.karede kare 

animasyonu olacaktır. Animasyonlar film klibinde yapılacaktır. Açılan kutudan seçilen yıldız 

veya kareye göre 1.karedeki OYNAT butonuna basıldığında seçilen animasyon 

başlayacaktır. 

- 1.karede açılan kutu eklenir ve yıldız, kare ifadeleri girilir. 

- Açılan kutuya örnek addan sec ismi verilir. 

- F6 ile 2.kareye geçilir. Ctrl + F8 ile film klibinde sağa doğru hereket eden yıldız 

animasyonu yapılır. 

- F6 ile 3.kareye geçilir. Ctrl + F8 ile film klibinde sola doğru hareket eden daire 

animasyonu yapılır. 

- 1.karede iken F9’a tıklanır ve stop(); yazılır. 

- 1.karedeki BAŞLAT butonu seçili iken F9’a tıklanır ve aşağıdaki kodlar yazılır: 

On (press) { 
if (sec.value== “Yıldız”) 
{ 
_root.gotoAndStop(2); 
} 
else 
 { 
_root.gotoAndStop(3); 
} 
} 
 

 
Hazır butonlarla Sahne Üzerindeki Daireyi Kontrol Etme : 
 

- Üst katmanda daire alt katmanda butonlar yer alır. 
- Ctrl + F8 ile film klibine girilir ve daireye sağa doğru hareket verilir.(1.karede solda, 

30.karede sağda ve 1-30 arası hareket arası oluştur…) 
- Sahneye tıklanır. Daire kitaplıktan sahneye sürüklenir. Özellikler panelinden film klibi 

başlığı altından örnek ad kısmına daire ismi verilir. 
- Daire katmanının 1.karesinde iken F9’a basılır ve ActionScript kod penceresine 

daire.stop(); yazılır. 
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- Alt katmana hazır butonlar pencere menüsü---ortak kitaplıklar---düğmeler---tüm 
klasörleri genişlet seçilir. 

- 5 adet hazır buton eklenir (play, stop…..) 
- Butonlara sırası ile (soldan sağa…)  

 
 
play butonu için; 
on (press) { 
 daire.play(); 
} 
 
 
Stop ve 1.kareye git için; 
on (press) { 
 daire.gotoAndStop(1); 
} 
 
 
Stop için; 
on (press) { 
 daire.stop(); 
} 
 
 
Bir sonraki kare için; 
on (press) { 
 daire.nextFrame(); 
} 
 
 
Bir önceki kare için; 
on (press) { 
 daire.prevFrame(); 
} 
 
 
 

SİZ YAPIN ? (Hazır butonlarla film klibinde çizilen yıldızı çizilen çember boyunca 
çember de gözükecek şekilde hareket ettirme ) 
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Flashta Buton Yapımı : 
Ctrl + F8 ile düğme eklenir. Yukarı karesinde iken kare çizilir ve üzerine isim yazılır, ve 
F6’ya basılarak üzeri karesinde iken (Mouse üzerine geldiğinde…) butonun alacağı yazı ve 
şekil yer alır. Tekrar F6’ya basılır. Aşağı karesinde butona Mouse ile tıkladığında alacağı 
şekil veya yazı yer alır. Tüm karelerdeki yazı ve şekiller birlikte seçilerek gruplanır. (Ctrl+G) 

   
 
Çizilen START ve STOP butonları ile film klibinde çizilen tekerleğin kontrolü: 

- Ctrl + F8 ile film klibi eklenir ve tekerlek çizilir. Ve 1.karede solda 50.karede tekerlek 
sağda olur. 

- 1-50 arası hareket arası oluştur işlemine tabi tutulur, 1-50 arasında herhangi bir karede 
döndürden SY seçilir. 

- Sahneye geçilir ve takerlek kitaplıktan sahneye alınarak özellikler penceresindeki 
örnek ad kısmından tekerlek ismi verilir. 

- Butonlar çizilir. 
- 1.karede iken F9’a basılır ve tekerlek.stop(); yazılır. 
- START butonuna; 

on (press) { 
 tekerlek.play(); 
}  

- STOP butonuna; 
on (press) { 
 tekerlek.stop(); 
} 

 komutları yazılır. 

           
 
Butonlarla Rollover Uygulaması : 
İstenilen kareye butona tıkladığımızda gidebileceğimiz gibi butonun üzerine Mouse ile 
gelindiğinde de aynı uygulama gerçekleştirilebilir. Bunun için on (rollOver) komutu 
kullanılır. Yani kareye gitmeyi sağlayacak kodlar aşağıdaki gibi yazılır:  
on (rollover){ 
  kodlar…. 
} 
  
Butonun üzerinden Mouse çekildiğinde gerçekleşecek olayların kodları ise aşağıdaki kod 
bloğuna yazılır. 
on (rollOut) { 
  kodlar…. 
} 
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K E T M L isimli butonun üzerine Mouse getirildiğinde “HOŞGELDİNİZ” , mouse 
çekildiğinde “GÜLE GÜLE” mesajlarını butonla aynı karedeki dinamik metin 
kutusunda gösterme: 
 

- Buton oluşturulur. 
- Dinamik metin kutusu eklenir ve değ kısmından mesaj ismi verilir. 
- Buton seçili iken F9’a basılır ve aşağıdaki kodlar yazılır: 

On (rollOver) { 
_root.mesaj = “HOŞGELDİNİZ” ; 
} 
 
On (rollOut) { 
_root.mesaj = “GÜLE GÜLE”; 
} 

 
SİZ YAPIN ? (1.karedeki ANİMASYON isimli butonun üzerine gidildiğinde 
2.karedeki yıldız animasyonunun ve Mouse çekildiğinde de 3.karedeki daire 
animasyonunun çalışmasını sağlayınız. ) 

 
Klavyedeki yön tuşları ile animasyon kontrolü: 
 
On (keypress “<left>”)      � Animasyon sol oka basıldığında çalışır. 
On (keypress “<right>”)    � Animasyon sağ oka basıldığında çalışır. 
On (keypress “<up>”)        � Animasyon yukarı oka basıldığında çalışır. 
On (keypress “<down>”)   � Animasyon aşağı oka basıldığında çalışır. 
 
 

SİZ YAPIN ? (Aşağıdaki engeli klavyedeki yukarı aşağı ok tuşlarına basarak hareket 
ettirecek animasyonu aşağıdaki açıklamalar doğrultusunda oluşturunuz.) 

 
 

 
Hatırlatma : Şeklin merkezini taşımak için serbest dönüştürme (Q) aracına tıklanır ve 
merkezdeki küçük daire(1nolu) Mouse ile istenen noktaya (örneğin 2 noktasına) taşınır. 

Açıklama:  

- Animasyondaki ok tuşları kırmızı renktedir. 

- Klavyeden yukarı ok tuşuna basıldığında yukarı ok yeşil renge 

dönüp, engel yukarı gidip durarak yukarı ok tekrar kırmızı olacaktır. 

Bu durumda iken tekrar yukarı oka basılamayacaktır. (Çünkü engel 

zaten yukarıda) Aşağı oka engel yukarıda iken basıldığında aşağıya 

doğru gidip duracaktır. 
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SİZ YAPIN ? (Bilgisayardaki kayıtlı örnek resimlerden 4 tanesini kullanarak film 
klibinde bir albüm oluşturup sahnedeki hazır butonlar ile durdurma, oynatma, ileri, 
geri işlemlerini gerçekleştiren animasyon) 

      
 
Butona Link Verme :  
Buton seçili iken F9’a tıklanır ve aşağıdaki kodlar yazılır : 
On (press) { 
get URL (“http:// www.ketml.com”, _self); 
} 
NOT: On (press) yerine On (release) komutu da kullanılabilir ! 
 
SİZ YAPIN ? (Aşağıdaki animasyonu oluşturunuz.) 
 

 
 
Müzik Ekleme :  
Müzik animasyonun bulunacağı katmana eklenebileceği gibi ayrı bir katmana da eklenebilir.  

- Dosya menüsünden içeri aktar kitaplığa aktar seçeneklerinden eklenecek müzik 
dosyadan seçilir. 

- Özellikler panelinden ses seçeneğinden kitaplığa eklenen müzik seçilir. 
- Müziği animasyon boyunca dönmesi için döngü seçilmelidir. 
- Özellikler panelindeki senkronizasyon kısmından müziğin hangi karelerde başlayıp, 

hangi karelerde biteceği başlat ve doldur butonları ile gerçekleştiriniz. 
 
Video Ekleme : 
Dosyadan içe aktar ve video aktar seçeneğinden eklenecek video gözat kısmından seçilir. 
İlk seçenek aynen bırakılır. İleri butonuna basılarak gelen ekrandan Clear Over All seçeneğine 
tıklanır. 
 
SİZ YAPIN ? (Aşağıdaki animasyonda gri bilyenin klavyedeki sol, sağ ve yukarı oklar 
ile hareketini gerçekleştiriniz. ) 
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SİZ YAPIN ? 

 
 
 
 
 
 
 
 
SİZ YAPIN ? 
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SİZ YAPIN ? 

 
 
SİZ YAPIN ? 

 


